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WARRANTY
The Anritsu products listed on the title page are warranted against defects in materials and
workmanship for three years from the date of shipment.
Anritsu’s obligation covers repairing or replacing products which prove to be defective during the
warranty period. Buyers shall prepay transportation charges for equipment returned to Anritsu for
warranty repairs. Obligation is limited to the original purchaser. Anritsu is not liable for consequential
damages. Accessories included with this product are not included in the standard warranty.

LIMITATION OF WARRANTY
The foregoing warranty does not apply to Anritsu connectors that have failed due to normal wear. Also,
the warranty does not apply to defects resulting from improper or inadequate maintenance,
unauthorized modification or misuse, or operation outside of the environmental specifications of the
product. No other warranty is expressed or implied, and the remedies provided herein are the Buyer’s
sole and exclusive remedies.

DISCLAIMER OF WARRANTY 
DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, ANRITSU COMPANY AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE
PRODUCT. THE USER ASSUMES THE ENTIRE RISK OF USING THE PRODUCT. ANY LIABILITY
OF PROVIDER OR MANUFACTURER WILL BE LIMITED EXCLUSIVELY TO PRODUCT
REPLACEMENT.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL ANRITSU COMPANY OR ITS SUPPLIERS BE LIABLE
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF ANRITSU
COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY
NOT APPLY TO YOU.

TRADEMARK ACKNOWLEDGMENTS
VxWorks is a registered trademark, and WindML is a trademark of Wind River Systems, Inc.
VNA Master is a trademark of Anritsu Company. Google Earth is a trademark of Google Inc.
Windows is a registered trademark of Microsoft Corporation.

NOTICE
Anritsu Company has prepared this manual for use by Anritsu Company personnel and customers as a
guide for the proper installation, operation and maintenance of Anritsu Company equipment and
computer programs. The drawings, specifications, and information contained herein are the property of
Anritsu Company, and any unauthorized use or disclosure of these drawings, specifications, and
information is prohibited; they shall not be reproduced, copied, or used in whole or in part as the basis
for manufacture or sale of the equipment or software programs without the prior written consent of
Anritsu Company.

UPDATES
Updates, if any, can be downloaded from the Anritsu Web site at:
http://www.anritsu.com
For the latest service and sales contact information in your area, please visit:
http://www.anritsu.com/contact.asp
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CE Conformity Marking

Anritsu affixes the CE Conformity marking onto its conforming products in accordance with 
Council Directives of The Council Of The European Communities in order to indicate that 
these products conform to the EMC and LVD directive of the European Union (EU).

C-tick Conformity Marking

Anritsu affixes the C-tick marking onto its conforming products in accordance with the 
electromagnetic compliance regulations of Australia and New Zealand in order to indicate 
that these products conform to the EMC regulations of Australia and New Zealand.

Notes On Export Management

This product and its manuals may require an Export License or approval by the government 
of the product country of origin for re-export from your country.

Before you export this product or any of its manuals, please contact Anritsu Company to 
confirm whether or not these items are export-controlled.

When disposing of export-controlled items, the products and manuals need to be broken or 
shredded to such a degree that they cannot be unlawfully used for military purposes.

Mercury Notification

This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated 
due to environmental considerations. Please contact your local authorities for disposal or 
recycling information.
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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu 
Company uses the following symbols to indicate safety-related information. For your own 
safety, please read the information carefully before operating the equipment.

Symbols Used in Manuals

Safety Symbols Used on Equipment and in Manuals
The following safety symbols are used inside or on the equipment near operation locations to 
provide information about safety items and operation precautions. Ensure that you clearly 
understand the meanings of the symbols and take the necessary precautions before operating 
the equipment. Some or all of the following five symbols may or may not be used on all 
Anritsu equipment. In addition, there may be other labels attached to products that are not 
shown in the diagrams in this manual.

Danger

This indicates a risk from a very dangerous condition or procedure that 
could result in serious injury or death and possible loss related to equipment 
malfunction. Follow all precautions and procedures to minimize this risk.

Warning This indicates a risk from a hazardous condition or procedure that could 
result in light-to-severe injury or loss related to equipment malfunction. 
Follow all precautions and procedures to minimize this risk.

Caution

This indicates a risk from a hazardous procedure that could result in loss 
related to equipment malfunction. Follow all precautions and procedures to 
minimize this risk.

This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle.

This indicates a compulsory safety precaution. The required operation is 
indicated symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically 
in or near the triangle.

This indicates a note. The contents are described in the box.

These indicate that the marked part should be recycled.
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For Safety

Warning Always refer to the operation manual when working near locations at 
which the alert mark, shown on the left, is attached. If the operation, 
etc., is performed without heeding the advice in the operation 
manual, there is a risk of personal injury. In addition, the equipment 
performance may be reduced. Moreover, this alert mark is sometimes 
used with other marks and descriptions indicating other dangers.

Warning

When supplying power to this equipment, connect the accessory 
3-pin power cord to a 3-pin grounded power outlet. If a grounded 
3-pin outlet is not available, use a conversion adapter and ground the 
green wire, or connect the frame ground on the rear panel of the 
equipment to ground. If power is supplied without grounding the 
equipment, there is a risk of receiving a severe or fatal electric shock.

Warning

This equipment can not be repaired by the operator. Do not attempt to 
remove the equipment covers or to disassemble internal 
components. Only qualified service technicians with a knowledge of 
electrical fire and shock hazards should service this equipment. 
There are high-voltage parts in this equipment presenting a risk of 
severe injury or fatal electric shock to untrained personnel. In 
addition, there is a risk of damage to precision components.

Caution

Electrostatic Discharge (ESD) can damage the highly sensitive 
circuits in the instrument. ESD is most likely to occur as test devices 
are being connected to, or disconnected from, the instrument’s front 
and rear panel ports and connectors. You can protect the instrument 
and test devices by wearing a static-discharge wristband. 
Alternatively, you can ground yourself to discharge any static charge 
by touching the outer chassis of the grounded instrument before 
touching the instrument’s front and rear panel ports and connectors. 
Avoid touching the test port center conductors unless you are 
properly grounded and have eliminated the possibility of static 
discharge.

Repair of damage that is found to be caused by electrostatic 
discharge is not covered under warranty.

Warning This instrument is supplied with a rechargeable battery that could 
potentially leak hazardous compounds into the environment. These 
hazardous compounds present a risk of injury or loss due to 
exposure. Anritsu Company recommends removing the battery for 
long-term storage of the instrument and storing the battery in a 
leak-proof, plastic container. Follow the environmental storage 
requirements specified in the instrument data sheet.
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Chapter 1 — General Information

1-1 Introduction
This chapter provides information about frequency range, available options, additional 
documents, general overview, preventive maintenance, and annual verification requirements 
for the Anritsu Handheld MS2024B, MS2025B, MS2034B, and MS2035B VNA Master 
models. 

Throughout this manual, the terms VNA Master and MS20xxB refer to the MS2024B, 
MS2025B, MS2034B, and MS2035B. The term MS202xB refers to the MS2024B and the 
MS2025B, and the term MS203xB refers to the MS2034B and the MS2035B. 

1-2 Contacting Anritsu      
To contact Anritsu, please visit:

http://www.anritsu.com/contact.asp 

From here, you can select the latest sales, select service and support contact information in 
your country or region, provide online feedback, complete a "Talk to Anritsu" form to have 
your questions answered, or obtain other services offered by Anritsu.

Updated product information can be found on the Anritsu web site:

http://www.anritsu.com/

Search for the product model number. The latest documentation is on the product page under 
the Library tab:

http://www.anritsu.com/en-us/products-solutions/products/MS2024B.aspx    

http://www.anritsu.com/en-us/products-solutions/products/MS2025B.aspx    

http://www.anritsu.com/en-us/products-solutions/products/MS2034B.aspx    

http://www.anritsu.com/en-us/products-solutions/products/MS2035B.aspx    

1-3 Anritsu Service Centers    
For the latest service and sales information in your area, please visit the following URL:

http://www.anritsu.com/Contact.asp 

and choose a country for regional contact information.
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1-4 Additional Documents
This user guide is specific to the VNA Master MS20xxB (models MS2024B, MS2025B, 
MS2034B, and MS2035B) and includes a general description of the instruments. Additional 
instrument functions and descriptions of optional measurement capabilities are described in 
measurement guides. 

Refer to Appendix A, “Supplemental Documentation” for a list of measurement guides and 
their Anritsu part numbers. Measurement guides are provided on the document disc that is 
shipped with each instrument. Updated measurement guides are available for download (at 
no charge) from the VNA Master product Web pages listed previously.

1-5 VNA Master Specifications
General and performance specifications, instrument options, standard accessories, and 
optional accessories are described in the VNA Master Technical Data Sheet, (Anritsu part 
number 11410-00549). The technical data sheet is available on the Anritsu Web site:
http://www.anritsu.com  

1-6 Available Models and Accessories   
Table 1-1 lists the VNA Master models and frequency ranges that are described in this User 
Guide. Refer to the VNA Master Technical Data Sheet for a list and descriptions of available 
accessories.

Table 1-1. VNA Master Models and Frequency Ranges

Model  Frequency Range

MS2024B Vector Network Analyzer, 500 kHz to 4 GHz

MS2025B Vector Network Analyzer, 500 kHz to 6 GHz 

MS2034B Vector Network Analyzer, 500 kHz to 4 GHz
and Spectrum Analyzer, 100 kHz to 4 GHz

MS2035B Vector Network Analyzer, 500 kHz to 6 GHz
and Spectrum Analyzer, 100 kHz to 6 GHz
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1-7 Identifying the Connections 
The MS2024B and MS2025B have the connectors shown in Figure 1-1. For details, refer to 
Figure 2-8. 

The MS2034B and MS2035B have the connectors shown in Figure 1-2. For details, refer to 
Figure 2-9. 

Model physical characteristics are in the Technical Data Sheet (refer to Table A-2, 
“VNA Master Related Documents” on page A-1).

Figure 1-1. MS2024B and MS2025B Connectors

Figure 1-2. MS2034B and MS2035B Connectors
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1-8 General Description
The MS20xxB VNA Master is an integrated multi-functional test instrument with a 1-path, 
2-port Vector Network Analyzer that eliminates the need to carry and learn multiple test 
sets. In addition, the MS203xB can be configured to include a Spectrum Analyzer, 
Interference Analyzer with Interference Mapping capabilities, Coverage Mapping, Channel 
Scanner, AM/FM/PM Analyzer, and High Accuracy Power Meter. A GPS receiver can be 
added to both the MS202xB and the MS203xB VNA Master models.

The bright 8.4 inch TFT color display provides easy viewing in a variety of lighting conditions, 
and the combination of a touch screen and keypad enables you to navigate menus with the 
touch screen and to enter numbers with the keypad. All VNA Master models are equipped 
with a Li-Ion battery delivering more than four hours of battery life for the MS202xB 
VNA Masters and more than three hours of battery life for the MS203xB VNA Masters.

Time and date stamping of measurement data is automatic. The internal memory provides 
for the storage and recall of up to 1000 measurement setups and up to 1000 traces. External 
storage can be used for bulk measurement storage. Measurements and setups can be stored 
in a USB flash drive or transferred to a PC by using the included USB cable. Use 
Line Sweep Tools (LST) for certain VNA measurements and Master Software Tools for 
spectrum analysis measurements. Cable parameters can be added to list boxes by creating 
them in Line Sweep Tools. Signal Standard parameters can be added to list boxes by creating 
them in Master Software Tools. Refer to Chapter 8, “Anritsu PC Software Tools” for a brief 
overview of these software tools. 

Note

Not all after-market USB drives are compatible with the VNA Master. Many drives 
come with a second partition that contains proprietary firmware. This partition must 
be removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. You might also try reformatting a drive that 
contains a single partition using FAT32 format.
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1-9 Soft Carrying Case  
The VNA Master can be operated while in the soft carrying case (refer to the Technical Data 
Sheet for ordering information). On the back of the case is a large storage pouch for 
accessories and supplies.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front 
panel of the case. When closed, the front panel supports the shape of the case while you 
are inserting the VNA Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
closed and laying flat.

3. Open the zippered back of the case.

4. Insert the instrument face down into the case, take care that the connectors are 
properly situated in the case top opening. You may find it easier to insert the 
connectors first, then pull the corners over the bottom of the VNA Master.

5. Close the back panel and secure with the zipper to secure the VNA Master.

The soft carrying case includes a detachable shoulder strap, which can be connected to the 
D-rings of the case.

Note

The soft case has two zippers near the back. The zipper closer to the front of the 
case opens to install and remove the instrument. The zipper closer to the back of 
the case opens an adjustable support panel that can be used to provide support for 
improved stability and air flow while the instrument is in the case. This support 
panel also contains the storage pouch.

Figure 1-3. Instrument (MS2035B) Inserted into the Soft Carrying Case 

Caution
The soft case has panel openings for the fan inlet and exhaust ports. Do not block 
the air flow through the panels when the unit is operating.
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1-10 Tilt Bail Stand  
A Tilt Bail is attached to the back of the VNA Master for desktop operation. The tilt bail 
provides two settings of backward tilt for improved stability. To deploy the tilt bail, pull the 
bottom of the tilt bail away from the back of the instrument. To store the tilt bail, push the 
bottom of the bail towards the back of the instrument until it attaches to the VNA Master. 

Note
Do not use the tilt bail while the instrument is in the soft case. The soft case has an 
adjustable support panel in the back zipper.

Figure 1-4. Tilt Bail Extended 
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1-11 Preventive Maintenance  
VNA Master preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connectors on the instrument and on all accessories. Clean the VNA Master 
with a soft, lint-free cloth dampened with water or with water and a mild cleaning solution.

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the 
N(m) connectors must be unbroken and uniform in appearance. If you are unsure whether the 
connectors are undamaged, gauge the connectors to confirm that the dimensions are correct.

Visually inspect test port cables. The test port cable should be uniform in appearance and not 
stretched, kinked, dented, or broken.

1-12 Calibration Requirements — Vector Network Analyzer
The VNA Master is a field portable unit operating in the rigors of the test environment. In 
order to ensure measurement accuracy, RF calibration (OSLT, for example) must be 
performed prior to making a measurement in the field.

Anritsu recommends allowing the instrument to warm up to typical operation temperature (a 
minimum of 15 minutes) before calibrating. The instrument will require a new OSL 
calibration if the internal instrument temperature changes more than 15 ºC after calibration.

The VNA Master has no field-adjustable components. The RF calibration components, 
however, are crucial to the integrity of the calibration and must be periodically verified to 
ensure their performance. This is especially important if the components have been dropped 
or over-torqued. 

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.

Note

For best calibration results (compensation for all measurement uncertainties), 
ensure that the calibration is performed at the end of the test port or optional 
extension cable (that is, at the same point that the device that is to be tested (DUT) 
will be connected). 

Caution  

For best results, use an Anritsu phase stable Test Port Extension Cable, such as 
those listed in the Technical Data Sheet for your instrument (refer to Appendix A). 
Use of a typical laboratory cable to extend the VNA Master test port to the device 
under test, or any bending of the cable subsequent to the OSL or OSLT calibration, 
may cause uncompensated phase reflections inside the cable. Reflections of this 
type cause measurement errors, which are more pronounced at higher frequencies.
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1-13 Annual Verification  
Anritsu recommends an annual calibration and performance verification of the VNA Master 
and the OSL calibration components and InstaCal module by local Anritsu service centers.

The VNA Master is self-calibrating and has no field-adjustable components. The OSL 
calibration components are crucial to the integrity of the calibration. As a result, they must be 
verified periodically to ensure performance conformity. This is especially important if the 
OSL calibration components have been accidentally dropped or over-torqued. Contact 
information for Anritsu Service Centers is available at:

http://www.anritsu.com/Contact.asp

1-14 ESD Cautions    
The VNA Master, like other high performance instruments, is susceptible to ESD damage. 
Coaxial cables and antennas can easily build up a static charge, which (if allowed to discharge 
by connecting directly to the VNA Master without first discharging the static charge) may 
damage the instrument input circuitry. Operators must be aware of the potential for ESD 
damage and must take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these standards apply to the VNA Master, Anritsu 
Company recommends that any static charges that may be present be dissipated before 
connecting coaxial cables or antennas to the VNA Master. This may be as simple as 
temporarily attaching a short or load device to the cable or antenna prior to attaching to the 
VNA Master. Remember that the operator may also carry a static charge that can cause 
damage. Following the practices outlined in these standards helps to ensure that a safe 
environment exists for both personnel and equipment.
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1-15 Battery Replacement  
The battery can be replaced without the use of tools. The battery compartment is located on 
the lower left side of the instrument (when you are facing the measurement display). Refer to 
Figure 1-5. To remove the battery:

1. Slide the catch toward the bottom of the instrument.

2. Tilt the top of the door away from the unit.

3. Lift out the battery door.

4. Remove the battery pack from the instrument by grabbing the battery lanyard and 
pulling out.

Replacement is the opposite of removal. The battery key side (slot below the contacts) must be 
facing the front on the unit and slides in first. Press the battery inward firmly to seat the 
contacts, then reinstall the door. 

Note
When inserting the battery, the battery label must face the back of the instrument, 
and the guide slot on the battery must be below the contacts. If the battery door 
does not latch closed, the battery may be inserted incorrectly.

Figure 1-5. Battery Compartment
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The battery that is supplied with the VNA Master may need charging before use. The battery 
can be charged while it is installed in the VNA Master by using either the AC-DC Adapter or 
the DC adapter, or outside the VNA Master with the optional Dual Battery Charger. Refer to 
“Battery Symbols” on page 2-17 for a description of battery symbols. 

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this 
instrument.

Anritsu Company recommends removing the battery for long-term storage of the 
instrument.

Caution 

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
then discontinue use immediately.
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1-16 Secure Environment Workplace  
This section describes the types of memory in the VNA Master, how to delete stored user files 
in internal memory, and recommended usage in a secure environment workplace.

VNA Master Memory Types

The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM 
memory. The instrument does not have a hard disk drive or any other type of volatile or 
non-volatile memory.

Disk-On-A-Chip (DOC)

DOC is used for storage of instrument firmware, factory calibration information, user 
measurements, setups, and *.jpg screen images. User information stored on the DOC is 
erased by the master reset process described in section “Erase All User Files in Internal 
Memory” on this page.

EEPROM

This memory stores the model number, serial number, and calibration data for the 
instrument. Also stored here are the user-set operating parameters such as frequency range. 
During the master reset process, all operating parameters that are stored in the EEPROM 
are set to standard factory default values.

RAM Memory

This is volatile memory used to store parameters needed for the normal operation of the 
instrument along with current measurements. This memory is reset whenever the 
instrument is restarted.

External USB Flash Drive (not included with the instrument)

This memory may be selected as the destination for saved measurements and setups for the 
instrument. You can also copy the contents of the internal disk-on-chip memory to the 
external flash memory for storage or data transfer. The external Flash USB can be 
reformatted or sanitized using software on a PC. 

Refer to the Chapter 4, “File Management” for additional information on saving and copying 
files to the USB flash drive.

Erase All User Files in Internal Memory   

Perform a Master Reset:

1. Turn the instrument on.

2. Press the Shift button then the System (8) button.

3. Press the System Options soft key (submenu key).

4. Press the Reset key, then the Master Reset key.

5. A dialog box is displayed on the screen warning that all settings will be returned to 
factory default values and all user files will be deleted. This deletion is a standard file 
delete and does not involve overwriting exiting information.

6. Press the ENTER button to complete the master reset.

7. The instrument reboots, and the reset is complete.
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Recommended Usage in a Secure Environment

Set the VNA Master to save files to an external USB Flash drive:

1. Attach the external Flash drive and turn on the instrument.

2. Press the Shift button then the File (7) button.

3. Press the Save soft key (submenu key).

4. Press the Change Save Location soft key, then select the USB drive with the 
rotary knob, Up/Down arrow keys, or the touchscreen.

5. Press the Set Location soft key.

The external USB drive is now the default location for saving files.

Note

Not all after-market USB drives are compatible with the VNA Master. Many drives 
come with a second partition that contains proprietary firmware. This partition must 
be removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. You might also try reformatting a drive that 
contains a single partition using FAT32 format.
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Chapter 2 — Instrument Overview 

2-1 Introduction
This chapter provides a brief overview of the Anritsu VNA Master. The intent of this chapter 
is to acquaint you with the instrument. For detailed measurement information, refer to a 
specific measurement guide, as listed in Appendix A, “Supplemental Documentation”. 

2-2 Turning On the VNA Master  
The Anritsu VNA Master MS202xB models are capable of approximately four hours, and the 
MS203xB models are capable of approximately three hours, of continuous operation from a 
fully charged, field-replaceable battery (refer to Section 1-15 “Battery Replacement” 
on page 1-9). 

The VNA Master can also be operated from an external power source (which also 
simultaneously charges the battery). This can be achieved with either the Anritsu AC-DC 
Adapter or the Automotive Cigarette Lighter Adapter. Both items are included with the 
VNA Master. 

Caution 

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 60 Watts at 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
discontinue use immediately. 
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To turn on the VNA Master, press the green On/Off button on the front panel (Figure 2-1). 
The VNA Master takes approximately sixty seconds to complete power warm-up and to load 
the application software. At the completion of this process, the instrument is ready for use. 

1 Instrument Settings Summary (unique to each trace)

2 Fan Exhaust Port

3 Fan Inlet Port

4 Touch Screen Soft keys

5 Menu Key

6 Shift Key

7 Numeric Keypad and Shift Menu Keys (printed in blue above 1 through 9) 

8 Fan Inlet Port

9 On/Off Button

10 Touch Screen Function Hard Keys

Figure 2-1. VNA Master Overview
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2-3 Front Panel Overview 
The VNA Master menu-driven interface is easy to use and requires little training. The 
VNA Master uses a touch screen and keypad for data input. The five bottom menu keys and 
eight soft keys (submenu keys) on the right side are touch screen keys. The menu and soft 
keys vary depending upon the selected mode of operation. Refer to “Mode Selector Menu” 
on page 2-21.

Numeric keys 1 through 9 are dual purpose, depending upon the current mode of operation. 
The dual-purpose keys are labeled with a number on the key itself, and the alternate function 
is printed in blue above each of the keys. Use the blue Shift key to access the functions that 
are printed on the panel. The Escape key, used for aborting data entry, is the oval button 
located above numeric key 9. The rotary knob, the four arrow keys, and the keypad can be 
used to change the value of an active parameter. 

The Menu key provides graphical icons of all of the installed measurement modes and user 
defined shortcuts (refer to “Menu Key” on page 2-4). The locations of the keys are shown in 
Figure 2-1. 

Caution
Keep the fan inlet and exhaust ports clear of obstructions at all times for proper 
ventilation and cooling of the instrument.
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Front Panel Keys

Menu Key

The Menu key (or button) is above the arrow keys, which surround the Enter key. Press the 
Menu key to display a grid of shortcut icons for installed measurement modes and any 
user-selected menus and setup files that may have been added. 

Figure 2-2 shows the Menu key screen with shortcut icons for the installed measurement 
modes. Touch one of the icons in the top row to change modes. These top-row icons are 
preinstalled and cannot be moved or deleted. 

Figure 2-2.  Menu Key Screen, Icons for Installed Measurements

Note
The display of the Menu screen varies depending on your VNA Master model and 
installed options.
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Figure 2-3 shows the Menu key screen with shortcut icons for the installed measurement 
modes plus four rows of user-defined shortcuts to menus and setup files. 

Press and hold down any touch-screen key for a few seconds to add a shortcut of that key to 
this screen. To add shortcut setup files (*.stp), open the recall menu and hold down on the 
file name for several seconds. Then select the location for the shortcut. 

User-defined shortcuts stay in memory until deleted. To delete or move a shortcut button, 
press the Menu key, then press and hold the shortcut for approximately 3 seconds. The 
Customize Button dialog box opens to allow a button to be deleted or moved. Press Esc to exit 
the Menu shortcut display. 

Figure 2-3.  Menu Key Screen

Note
The Factory Default reset deletes all user-created shortcut icons from the Menu 
screen. Refer to the “Reset Menu” on page 5-10 for additional information.
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Help for the Menu shortcut screen is available by pressing the Help icon in the lower-right 
corner of the display, as shown in Figure 2-4 on page 2-6.
 

Esc Key 

Press this key to cancel any setting that is currently being made. 

Enter Key 

Press this key to finalize data input or to select a highlighted item from a list.

Arrow Keys 

The four arrow keys (around the Enter key) are used to scroll up, down, left. The arrow keys 
can often be used to change a value or to change a selection from a list. The Left/Right arrow 
keys sometimes change values or move through selections in different increments than the 
Up/Down arrow keys. The arrow keys are also used to move markers. 

Shift Key  

Pressing the Shift key followed by pressing a number key executes the function that is 
indicated in blue text above the number key. When the Shift key is active, its icon is displayed 
at the top-right of the measurement display area near the battery charge indicator. 

Figure 2-4. Menu Help

Figure 2-5. Shift Key Icon
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Number Keypad 

The Number keypad has two functions: The primary function is number entry. The 
secondary function is to list various menus. Refer to “Keypad Menu Keys (1 to 9)” on page 2-7.

Rotary Knob 

Turning the rotary knob changes numerical values, scrolls through selectable items from a 
list, and moves markers. Values or items may be within a dialog box or an edit window. 

Touch Screen Keys 

Main Menu Touch Screen Keys   

These five main menu keys (also called hard keys or function hard keys) are horizontally 
arranged along the lower edge of the touch screen. The main menu key (hard key) functions 
change to match specific instrument Mode settings. The hard keys generate function-specific 
submenus. The various measurement modes are selected by pressing the Shift key and then 
the Mode (9) key. Descriptions of the various measurement modes can be found in the 
applicable Measurement Guides listed in Appendix A.

Touch Screen Submenu (Soft) Keys  

These submenu keys (also called soft keys) are arranged along the right-hand edge of the 
touch screen. The soft key labels change as instrument measurement settings change. The 
current submenu title is shown at the top of the submenu key block.

Keypad Menu Keys (1 to 9)

Pressing the Shift key followed by pressing a number key selects the menu function that is 
printed in blue characters above the number key. Refer to Figure 2-1 on page 2-2.

Not all Secondary Function Menus are active in various measurement modes. If any one of 
these menus is available in a specific instrument mode of operation, then it can be called from 
the number keypad. It may also be available from a hard key or a soft key. 

The Preset Menu (1) and System Menu (8) are described in Chapter 5, “System Operations ”. 
The Sweep Menu (3), Measure Menu (4), Trace Menu (5), and Limit Menu (6) vary depending 
on measurement mode, refer to the Measurement Guides listed in Appendix A for 
information. The File Menu (7) is described in Chapter 4, “File Management”. The Mode 
Menu (9) is described in “Mode Selector Menu” on page 2-21. 

Touch Points  

Touch Points on the display screen provide additional functionality and convenience. These 
points are described in the measurement guides for specific measurement modes. The 
measurement guides are listed in Appendix A.

Touch Screen Calibration   

Press Shift then 0 (zero) to open the Calibrate Touch Screen display. Press Enter to start the 
calibration or Esc to cancel.

Note
Available measurement modes are based on the model and the options that are 
purchased. Refer to Table 1-1 on page 1-2 for additional information. 
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LED Indicators  

Power LED

The Power LED is located to the left of the On/Off key. The LED is solid green when the unit 
is on and slowly blinks when the unit is off but has external power.

Charge LED

The Charge LED is located to the right of the On/Off key. The LED slowly blinks when the 
battery is charging and is solid green when the battery is fully charged. It slowly blinks when 
the unit is off but has external power.
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2-4 Display Overview    
Figure 2-6 illustrates some of the key information areas of the VNA Master sweep window in 
Vector Network Analyzer mode. For detailed information, refer to the Measurement Guides 
that are listed in Appendix A, “Supplemental Documentation”. 

1 Instrument Settings Summary (unique to each trace)

2 Trace 1 (TR1) data (within Instrument Settings Summary)

3 Instrument Settings Summary (applies to all traces)

4 Real Time Clock

5 GPS Icon

6 GPS location

7 Battery Charge indicator

8 Measurement description (within the Instrument Settings Summary)

9 Touch Screen Soft key Menu 

10 Trace 4 (TR4) display – S11 Log Mag

11 Touch Screen Function Hard Keys

Figure 2-6. VNA Display with GPS On
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Display Settings

In addition to the default color display, VNA Master offers the following display settings:     

Black and White for printing and viewing in broad daylight conditions (no color)

Invert Black and White exchanges black for white on the display for best color printing

Night Vision optimized for night-time viewing

High Contrast for other challenging viewing conditions
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Figure 2-7. VNA Master Display Settings 

Default Colors
Black & White

Night Vision

High Contrast Invert Black & White
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2-5 Test Panel Connector Overview 

MS2024B and MS2025B 

Test panel connectors for the VNA Master MS2024B are shown in Figure 2-8. 

1 External Reference In (not installed in MS202xB models)

2 External Trigger In (not installed in MS202xB models)

3 RF In (not installed in MS202xB models)

4 USB Mini-B (Full Speed, USB 2.0)

5 GPS Antenna (location when installed with Option 31))

6 External Power

7 USB Type A (Full Speed, USB 2.0)

8 Headphone

9 VNA Port 1 50 ohm (Green LED indicates the Port is Transmitting Power)

10 VNA Port 2 50 ohm (Green LED indicates the Port is Transmitting Power)

Figure 2-8. MS2024B Test Panel Connectors
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MS2034B and MS2035B 

Test panel connectors for the VNA Master MS2035B are shown in Figure 2-9. 

External Power 

The external power connector (refer to item “6” in Figure 2-9) is used to power the unit and for 
battery charging. Input is 12 VDC to 15 VDC at up to 5.0 A. The green flashing Power LED 
near the power switch indicates that the instrument has external power. 

1 External Reference In

2 External Trigger In

3 RF In 

4 USB Mini-B (Full Speed, USB 2.0)

5 GPS Antenna (with Option 31)

6 External Power

7 USB Type A (Full Speed, USB 2.0)

8 Headphone

9 Ethernet (with Option 411)

10 VNA Port 1 50 ohm (Green LED indicates the Port is Transmitting Power)

11 VNA Port 2 50 ohm (Green LED indicates the Port is Transmitting Power)

Figure 2-9. MS2035B Test Panel Connectors

Warning 

When using the AC-DC Adapter, always use a three-wire power cable that is 
connected to a three-wire power line outlet. If power is supplied without grounding 
the equipment in this manner, then the user is at risk of receiving a severe or fatal 
electric shock.

1 3

710 8

2 54

611 9
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USB Interface – Type A 

The VNA Master has two Type A USB connectors (refer to item “7” in Figure 2-9 
on page 2-13) that accept USB Flash Memory devices for storing measurements, setup data, 
and screen images. 

USB Interface – Mini-B  

The USB 2.0 Mini-B connector (refer to item “4” in Figure 2-9 on page 2-13) can be used to 
connect the VNA Master directly to a PC, as shown in Figure 2-10. The first time the 
VNA Master is connected to a PC, the normal USB device detection by the computer 
operating system will take place. The CD-ROM that is shipped with the instrument contains 
a driver for Windows XP that is installed when Master Software Tools is installed. Drivers 
are not available for earlier versions of the Windows operating system. During the driver 
installation process, place the CD-ROM in the computer drive and specify that the 
installation wizard should search the CD-ROM for the driver. 

Ethernet Interface (Option 411)  

On all VNA Master models MS20xxB with Option 411, the Ethernet connector can be used to 
connect the VNA Master directly to a PC. Refer to Appendix F, “LAN and DHCP” for more 
information.

Headset Jack 

The headset jack provides audio output from the built-in AM/FM/SSB demodulator for testing 
and troubleshooting wireless communication systems. The jack accepts a 2.5 mm 3-wire 
miniature phone plug such as those commonly used with cellular telephones. (refer to item 
“8” in Figure 2-9 on page 2-13)

Figure 2-10. MS2035B Connected to PC via USB Mini-B

Note
For proper detection, either Line Sweep Tools or Master Software Tools must be 
installed on the PC prior to connecting the VNA Master to the USB port.
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2-6 Connector Care 
Visually inspect connectors for general wear, for cleanliness, and for damage, such as bent 
pins or connector rings. Repair or replace damaged connectors immediately. Dirty connectors 
can limit the accuracy of your measurements. Damaged connectors can damage the 
instrument. Connection of cables carrying an electrostatic potential, excess power, or excess 
voltage can damage the connector or the instrument or both. Connection of cables with 
inadequate torque settings can affect measurement accuracy. Over torquing connectors can 
damage the cable, the connector, the instrument, or all of these items.

Connecting Procedure 

1. Carefully align the connectors.

The male connector center pin must slip concentrically into the contact fingers of the 
female connector.

2. Push connectors straight together. Do not twist or screw them together.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, then initially tighten by hand so that approximately 1/8 turn 
or 45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque. Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over torque the connector.

Disconnecting Procedure 

1. If a wrench is needed, then use an open-end wrench to keep the connector body from 
turning while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.
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2-7 VNA Master Connectors  

External Trigger In (50 ohm)    

A TTL signal that is applied to the External Trigger In female BNC input connector causes a 
single sweep to occur. Maximum input is ±50 VDC. In the Spectrum Analyzer mode, it is used 
in zero span, and triggering occurs on the rising edge of the signal. After the sweep is 
complete, the resultant trace is displayed until the next trigger signal arrives (refer to item 
“2” in Figure 2-9 on page 2-13).

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

External Reference In (50 ohm)    

The BNC female connector (refer to item “1” in Figure 2-9 on page 2-13) is used for connection 
of an external frequency reference. Maximum input is ±5 VDC. Press the External Reference 
soft key under the System menu and then the Application Options menu to set the reference 
to external (10 MHz). The amplitude of the External Reference should be between –10 dBm 
and +10 dBm.

To prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector. Do not overtighten the connector.

RF In (50 ohm)    

This connector (refer to item “3” in Figure 2-9 on page 2-13) provides the input 50 ohm 
interface for the Spectrum Analyzer function. Maximum input is specified in the Technical 
Data Sheet (for the Anritsu part number, refer to Appendix A). 

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

GPS Antenna Connector (Option 31) 

The GPS antenna connection on the VNA Master is type SMA-female (refer to item “5” in 
Figure 2-9 on page 2-13). The GPS function is described in Chapter 6, “GPS (Option 31) ”. 

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not overtighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

VNA Port-1 (50 ohm)    

This connector (refer to item “10” in Figure 2-9 on page 2-13) provides the input/output 
50 ohm interface for reflection measurements of the Vector Network Analyzer at Port 1.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).
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VNA Port-2 (50 ohm) 

This connector (refer to item “11” in Figure 2-9 on page 2-13) provides the input 50 ohm 
interface for transmission measurements of the Vector Network Analyzer at Port 2. Bias Tee 
output is also available from this port (with Option 10). 

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connector. Do not overtighten the connector. The recommended torque is 12 lbf·in to 
15 lbf·in (1.36 N·m to 1.70 N·m).

2-8 Symbols and Indicators
The following symbols and indicators indicate the instrument status or condition on the 
display.

The instrument settings that are unique to each trace are summarized in an information 
block on the left side of the measurement display screen (refer to item “1” in Figure 2-6). Each 
block contains the trace number followed by the S-parameter that is assigned to that trace 
(TR4: S21, for example). If the trace has Trace Math applied to it, then the math function is 
also displayed on that line (TR1: S11/M1, for example), where M1 is the memory that is 
associated with TR1, and the math function is Trace/Memory). The S-parameter that is 
assigned to the trace memory is shown (if enabled) at the top of each trace information block 
(M1: S11, for example). Each trace block also includes the Graph type, the smoothing 
percentage, the calibration status, and the scale (Resolution per Division and the Reference 
Value). The calibration status indicates whether the calibration is ON, OFF, or non-existent 
(--) for the specific S-parameter that is assigned to each trace. If the Calibration is ON, then 
its validity is also displayed (OK,?, or X).

For calibration procedures, refer to the Cable and Antenna Measurement Guide 
(PN: 10580-00241) listed in Appendix A. 

Battery Symbols  

The battery symbol above the display indicates the charge remaining in the battery. The 
colored section inside the symbol changes size and color with the charge level.

Green with Black Plug body: Battery is fully charged and external power is applied

Green: Battery is 30% to 100% charged

Yellow: Battery is 10% to 30% charged

Red: Battery 0% to 10% charged

Lightning Bolt: Battery is being charged (any color symbol, Figure 2-12)

Detailed battery information is also available in the Status dialog box (System > Status).

Figure 2-11. Battery Status
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When either the AC-DC Adapter or the Automotive Cigarette Lighter Adapter is connected, 
the battery automatically receives a charge, and the battery symbol with the lightning bolt is 
displayed (Figure 2-12). 

The green Charge LED flashes when the battery is charging, and remains on steady when the 
battery is fully charged. 

When operating from external power without a battery installed, the battery symbol is 
replaced by a red plug body (Figure 2-13). 

Additional Symbols

Single Sweep 

Single Sweep is selected. Press Continuous in the Sweep menu to resume continuous 
sweeping.

Floppy Disk Icon  

Shortcut to the Save submenu. Touch the icon to open the touch screen keyboard for saving 
measurements, setups, or screen displays.

Figure 2-12. Battery Charging Icon

Caution Use only Anritsu-approved batteries, adapters, and chargers with this instrument.

Figure 2-13. Battery Not Installed

Figure 2-14. Floppy Disk Icon
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2-9 Data Entry  

Numeric Values

Numeric values are changed using the rotary knob, arrow keys, or the keypad. Pressing one 
of the main menu keys (hard keys) displays a list of submenus on the right side of the touch 
screen. When the value on a soft key (submenu key) is displayed in red, it is ready for 
changing. When using the rotary knob or arrow keys the changing value is shown on the 
submenu and in red on the graticule. When using the keypad, the new value is shown in red 
on the graticule and the submenu changes to Units. Selecting a unit for the new value 
completes the entry.

Parameter Setting

Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll 
through a list of items or parameters with the arrow keys, the rotary knob, or the touch 
screen. These list boxes and edit boxes frequently display a range of possible values or limits 
for possible values.

Finalize the input by pressing the Enter key. At any time before finalizing the input, press the 
escape (Esc) key to abort the change and retain the previously existing setting.

Cable parameters can be added to list boxes by creating them in Line Sweep Tools (LST). 
Signal Standard parameters can be added to list boxes by creating them in Master Software 
Tools (MST).
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Text Entry  

When entering text, as when saving a measurement, the touch screen keyboard is displayed 
(Figure 2-15). Characters are entered directly with the touch screen keyboard. The keypad 
can be used for numeric entry. The left and right arrow keys scroll the cursor through the 
filename. Refer to “Save Menu” on page 4-9 for additional information.

Figure 2-15. Touch Screen Keyboard
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2-10 Mode Selector Menu  
To access the functions under the Mode menu, press the Shift key, then the Mode (9) key. Use 
the directional arrow keys, the rotary knob, or the touch screen to highlight the selection, and 
press the Enter key to select. The list of modes that appear in this menu varies depending 
upon the options that are installed and activated in the instrument. Figure 2-16 is an 
example of the Mode menu. Your instrument may not show the same list. The current mode is 
displayed below the battery symbol. 

The Menu key is another option to quickly change measurement modes. Press the Menu key 
then select one of the Measurement icons in the top two rows (Figure 2-2 on page 2-4). 

Figure 2-16. Mode Selector Menu 

Note
The display of the Mode Selector varies depending on VNA Master model and 
installed options.
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Chapter 3 — Quick Start Guide 

3-1 Introduction
This chapter provides a brief overview of basic measurement setups. For detailed 
measurement information, refer to a specific measurement guide listed in 
Appendix A, “Supplemental Documentation”. This chapter provides quick start measurement 
information for the following measurement modes:

• Section 3-3 “Vector Network Analyzer” on page 3-2

• Section 3-5 “Spectrum Analyzer” on page 3-9

3-2 Measurement Mode Selection
Press the Menu key and use the touch screen to select the appropriate measurement icon.

Figure 3-1.  Menu Screen with Icons for Installed Measurement Modes

Note The display of the Menu screen varies depending on installed options.
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3-3 Vector Network Analyzer
Set the instrument to Vector Network Analyzer mode as described in the previous section.

Selecting the Measurement Type

Press the Measure main menu key (hard key) and select the appropriate measurement.

Setting the Frequency 

1. Press the Freq/Dist main menu key (hard key).

2. Press the Start Freq soft key (submenu key) and use the keypad, rotary knob, or the 
arrow keys to enter the start frequency.

3. Press the Stop Freq soft key and use the keypad, rotary knob, or the arrow keys to enter 
the stop frequency.

Figure 3-2.  Measurement Menu
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Setting the Scale 

1. Press the Scale main menu key (hard key).

2. For Smith Charts, select the appropriate zoom level. The graph expands or compresses 
around the central reference impedance of the Smith Chart

3. For rectangular graphs, such as Log Mag or phase, press the Resolution per Div 
submenu key to change the scale between vertical divisions of the graph.

a. Press the Reference Value submenu key to change the value indicated by the 
arrow-shaped Reference Line indicator.

b. Press the Reference Line submenu key to change the location of the arrow-shaped 
reference line indicator. A value of 0 (zero) sets the reference line indicator to the 
bottom of the graph..

Turning On Markers  

1. Press the Marker main menu key (hard key).

2. Press the Marker soft key to open the Select Marker list box and then select a marker by 
scrolling with the rotary knob or the arrow keys, then press Enter. Unused markers are 
labeled OFF. The number on the Marker soft key indicates the active marker.

3. If desired, press the Marker on Trace soft key to select which trace is associated with the 
marker, or select All traces.

4. Use the rotary knob, arrow keys, or touch and drag to move the Marker. The frequency 
of the active Marker is shown in the upper-left corner of the display screen.

5. Delta Markers are available. For a selected marker, toggle the Marker Type soft key to 
select Ref, Delta, or Off. Assign the Delta marker to a reference marker by using the 
Avail Ref Mkr soft key

Peak and Valley Search Markers    

When making measurements, the Peak Search and Valley Search features can be used to 
quickly place a Marker on a maximum or minimum point of a trace. 

1. With an active marker, press the Marker Search soft key.

2. Press the Peak Search or the Valley Search soft key to find the maximum or minimum 
value on the trace that is associated with the current marker. If the Marker is on All 
traces, then this action finds the peak or valley of the trace that is currently active.

Note
For Amplitude in Smith Chart measurements, refer to “Smith Chart” in the Vector 
Network Analyzer Measurement Guide, listed in Appendix A.
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Find Marker Value  

Hunting for specific values on a trace can be useful, such as –3 dB points on a filter. The 
VNA Master allows you to do this quickly and easily. Each marker can be associated with a 
Find value.

1. With an active marker, press the Marker Search soft key.

2. Press the Enter Marker soft key to set the desired trace value for markers to find. When 
the value is entered, the active marker automatically finds the trace value nearest to 
the entered value.

3. At any time, the Find Marker Value soft key can be used to find the next point to the right 
of the current marker location whose value is closest to the Find value.

Setting Up Delta Markers   

If the intent is to conduct a delta measurement, then two markers are necessary: one to be 
the reference marker and one to be the delta marker. 

Example Setup:

1. Press the Marker main menu key (hard key).

2. Turn on Marker 1 (to be the Ref marker) and assign it to a trace. 

a. Press Marker and select MK1 from the list box. Then press Enter.

b. The Marker Type soft key is set by default to Ref.

c. Press Marker on Trace. Then scroll in the Select One list box to choose a trace, 
and press Enter.

3. Turn on Marker 2 and toggle the Marker Type from Ref to Delta.

4. Assign Marker 2 to Marker 1 by pressing the Avail Ref Mkr soft key to open the Select 
One list box. Scroll to choose trace 1 (TR1) and press Enter.

The fourth step allows you to specify marker delta on one trace, and it also allows you to 
specify marker delta between two traces (Ref marker and Delta marker on different traces). 

Note
The Select Marker list box includes the current location, readout style, and 
delta status (if they exist). Otherwise, it indicates Off.
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Setting a Single Limit Line 

1. Press Shift and then Limit (6) to enter the Limit menu.

2. Press the Limit On/Off key to turn on the Limit.

3. Press Single Limit and then use the numeric keypad, the arrow keys, or the rotary knob 
to change the limit value and then press Enter.

4. Press the Limit Alarm key to turn on or off the Limit Alarm.

Note
Refer to the Vector Network Analyzer Measurement Guide (listed in Appendix A) 
for creating multi-segment limit lines.

Figure 3-3. Single Limit Lines
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Setting Up Distance Domain (Option 501)  

This option is fully described in the Vector Network Analyzer Measurement Guide. Refer to 
Appendix A, “Supplemental Documentation” for a list of these guides and their Anritsu part 
numbers. Measurement Guides are available as free downloads from the Anritsu Web site.

3-4 Calibration Considerations  
Various 2-port calibrations are available in the VNA Master. Transmission response is the 
simplest and requires only one connection during calibration, but it does not correct for test 
port match errors. 1-Path 2-Port calibration requires four calibration connections and 
corrects for the transmit port match, but does not correct for the receive port. 

Note

The previously described calibration considerations omit isolation steps in which 
loads are connected to each test port. During the isolation step of the calibration 
procedure, the VNA Master measures the isolation between test ports in order to 
achieve best dynamic range performance.

The Vector Network Analyzer Calibration menu is the same one that is used in the 
Vector Voltmeter menu. Refer to section “Calibration Menus” in Chapter 5 of the 
Vector Network Analyzer Measurement Guide (refer to Appendix A) for more 
information about the calibration menu. Note that some calibration parameters are 
shared between the Vector Network Analyzer and Vector Voltmeter mode, and that 
some parameters are different because they were optimized for the specific mode 
application.
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1 VNA Master
2 Optional Test Port Cable at Port 2
3 Optional Test Port Cable at Port 1
4 Through Connection (Port 1 Connects to Port 2)
5 OSL (Open, Short, Load) Precision Calibration Components

Figure 3-4. 2-Port Calibration
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SHORT

LOAD

1
52

4

3
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When you perform a calibration, the correction coefficients are calculated for specific 
S-parameters (depending on the type of calibration chosen) and for instrument settings 
(frequency range, number of points, and power level). The term “calibration correction” refers 
to the measurement correction coefficients that are applied to measurements as a result of 
your calibration.

When calibration correction is On, the correction is applied to all applicable S-parameters. 
For example, if a Full S11 (1-port) calibration is performed, then only traces that measure S11 
have a valid calibration. For those traces, the calibration information data in the Instrument 
Settings Summary (item “1” in Figure 2-1 on page 2-2) shows “CAL: ON (OK)”. All other 
traces that do not measure S11 display “CAL: --” to indicate that no valid calibration is 
available for those traces. The calibration correction can also be turned off manually under 
the Calibration menu by toggling the Cal Correction soft key from On to Off. In that case, the 
display shows “CAL: OFF” for all traces that have valid correction data available. 

Note that “CAL: OFF” means that a calibration correction has been created, but it is not 
currently being used. This is different from “CAL: --”, which means that no valid calibration 
correction is available for the current setting.

When you have Cal Correction on, you cannot increase the frequency range or the number of 
points. You can, however, reduce the frequency range or decrease the number of points 
without forcing the calibration to become invalid. When reducing the frequency range, the 
VNA Master uses the appropriate points within the new frequency range that have correction 
coefficients applied to them. In that case, you can observe that the number of points that are 
being used for calibration correction are automatically reduced. 

If you reduce only the number of points, then the frequency range is not changed. The 
VNA Master finds a subset of the original points in the sweep that can be used. You can 
therefore notice that the instrument may not use the exact number of points that you have 
entered. It picks a specific number of points that allow the calibration correction to continue 
to be valid. If you use the rotary knob, you will more easily find the available number of 
points that can be set. For example, if you calibrated with 201 points, then you can observe 
that you can reduce the number of points to 101, 68, 51, 41, and so forth. 

If you change the source power setting, the calibration status is changed to “CAL: ON (?P)”, 
which indicates that source power has changed since the instrument was calibrated (from 
Low to High, or from High to Low). In this case, the calibration may still be valid, but a new 
calibration is recommended.

Another status information display that you may see is “CAL: ON (?T)” which indicates that 
the instrument temperature has deviated by more than a set amount since the time that the 
calibration was conducted. The calibration is most likely still valid, but a new calibration is 
recommended. If you see “CAL: ON (X)” on the display, then this indicates that the 
instrument temperature has deviated (since the time the calibration was conducted) by an 
amount that has more than likely rendered the calibration invalid. When this occurs, a new 
calibration is highly recommended before further measurements are conducted.

Only one calibration is available at one time. Performing a new calibration overwrites any 
existing calibration. You can, however, store a measurement setup (with CAL), which also 
stores the calibration. You can therefore have multiple calibrations available (as long as the 
calibration settings and conditions continue to apply).

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Quick Start Guide 3-5 Spectrum Analyzer

MS20xxB UG PN: 10580-00301  Rev. F 3-9

Cal Type

The Cal Type soft key is found in the Calibration Menu (shown in the VNA Measurement 
Guide). The Calibration Type list box provides the complete selection of available calibration 
types.

3-5 Spectrum Analyzer
Set the instrument to Spectrum Analyzer mode as described in Section 3-2 “Measurement 
Mode Selection” on page 3-1.

Set Start and Stop Frequencies 

1. Press the Freq main menu key (hard key). 

2. Press the Start Freq soft key (submenu key).

3. Enter the desired start frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the soft key labels change to GHz, MHz, 
kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect 
as pressing the MHz soft key.

4. Press the Stop Freq soft key.

5. Enter the desired stop frequency.

Enter the Center Frequency

1. Press the Freq main menu key (hard key).

2. Press the Center Freq soft key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency using the keypad, the soft key labels change to GHz, MHz, 
kHz, and Hz. Press the appropriate unit key. Pressing the Enter key has the same affect 
as pressing the MHz soft key.

The center frequency and span is shown at the bottom of the screen.

Select a Signal Standard 

1. Press the Freq main menu key (hard key).

2. Press the Signal Standard soft key. The Signal Standards dialog box opens.

3. Highlight a signal standard and press Enter to select.

4. Press the Channel soft key to change the channel value in the Channel Editor.

The signal standard is shown in yellow at the top of the screen.

Set the Measurement Bandwidth 

1. Press the BW main menu key (hard key) to display the BW menu.

• Press the RBW and/or the VBW soft key to manually change the values.

• Set RBW and VBW automatically by pressing the Auto RBW soft key or the 
Auto VBW soft key.
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2. Press the RBW/VBW soft key to change the resolution bandwidth and video bandwidth 
ratio.

3. Press the Span/RBW soft key to change the span width to resolution bandwidth ratio.

Set the Amplitude 

Press the Amplitude main menu key (hard key) to display the Amplitude menu.

Set Amplitude Reference Level and Scale

1. Press the Reference Level soft key and use the arrow keys, rotary knob, or the keypad to 
change the reference level. Press Enter to set the reference level value.

2. Press the Scale soft key and use the arrow keys, rotary knob, or the keypad to enter the 
desired scale. Press Enter to set the scale value.

Set Amplitude Range and Scale

1. Press the Auto Atten soft key to set an optimal reference level based on the measured 
signal.

2. Press the Scale soft key.

3. Enter the desired scale units by using the keypad, the arrow keys, or the rotary knob. 
Press Enter to set. The y-axis scale is automatically renumbered.

Power Offset Set Up for Compensating External Loss 

To obtain accurate results, compensate for any external attenuation by using power offset. 
In power offset mode, the compensation factor is in dB. (External attenuation can be created 
by using an external cable or an external high power attenuator.)

Press the RL Offset soft key and use the keypad, the arrow keys, or the rotary knob to enter 
the desired offset value. When using the rotary knob, the value changes in increments of 0.1 
dB. Using the Left/Right arrow keys changes the value in 10% increments of the value shown 
on the Scale soft key. When using the Up/Down arrow keys, the value changes in the 
increment shown on the Scale soft key. When using the keypad, enter the new value then 
press Enter or the dB soft key to set the value. The power offset is displayed in the instrument 
settings summary column on the left side of the measurement display.

Set the Span 

1. Press the Span main menu key (hard key) or the Freq hard key followed by the 
Span soft key.

2. To select full span, press the Full Span soft key. Selecting full span overrides any 
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span soft key.

Note
To quickly move the span value up or down, press the Span Up 1-2-5 or Span 
Down 1-2-5 soft keys These keys facilitate a zoom-in, zoom-out feature in a 1-2-5 
sequence.
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Single Limit Line 

Press the Limit menu key to display the Limit menu.

1. Press the Limit (Upper / Lower) soft key to select the desired limit line, Upper or Lower.

2. Activate the selected limit line by pressing the On Off soft key so that On is underlined.

3. Press the Limit Move soft key to display the Limit Move menu. Press the first Move Limit 
soft key and use the arrows keys, rotary knob, or keypad to change the dBm level of the 
limit line.

4. Press the Back soft key to return to the Limit menu.

5. If necessary, press the Set Default Limit soft key to redraw the limit line in view.

Create a Limit Envelope

1. Press Shift then Limit (6) to open the Limit menu.

2. Press Limit Envelope.

3. Press the Create Envelope key.

Figure 3-5. Limit Envelope
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Setting Up Markers 

Press the Marker main menu key (hard key) to display the Marker menu.

Selecting, Activating, and Placing a Marker

1. Press the Marker 1 2 3 4 5 6 soft key (soft key) and then select the desired marker by 
using the touch screen marker buttons. The selected marker is underlined on the 
Marker soft key. 

2. Press the On Off soft key so that On is underlined. The selected marker is displayed in 
red and ready to be moved.

3. Use the rotary knob to place the marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Selecting, Activating, and Placing a Delta Marker:

1. Press the Marker 1 2 3 4 5 6 soft key and select the desired delta marker. The selected 
marker is underlined.

2. Press the Delta On Off soft key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the rotary knob to place the delta marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Viewing Marker Data in a Table Format

1. Press the More soft key.

2. Press the Marker Table On Off soft key so that On is underlined. All marker and delta 
marker data are displayed in a table under the measurement graph.

Figure 3-6. Marker Table
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Select a Smart Measurement Type

In Spectrum Analyzer mode, press Shift then Measure (4) and select a smart one-button 
measurement using the soft keys (submenu keys). The Spectrum Analyzer Measurement 
Guide includes a Field Measurements section about smart measurements, which states:

In Spectrum Analyzer mode, smart one-button measurements are built-in for field strength, 
occupied bandwidth, channel power, adjacent channel power ratio, and carrier to interference 
ratio (C/I) tests. In addition, AM/FM/SSB demodulation is available to aid in the 
identification of interfering signals. 

Figure 3-7. Spectrum Analyzer Measure Menu with Smart Measurements

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



3-6 Saving Measurements Quick Start Guide 

3-14 PN: 10580-00301  Rev. F MS20xxB UG

3-6 Saving Measurements 
Measurement files can be stored in the following formats:

*.jpg JPEG images, filename.jpg

*.mna Measurements, filename.mna

*.stp Setups, filename.stp

*.s2p S2P (SnP), filename.s2p

*.spa Spectrum Analyzer Measurements, filename.spa

*.csv Text file with Comma Separated Values (CSV), filename.csv

*.txt Text file with tab separated values, filename.txt

*.lim Limit lines, filename.lim

Saving files in .mna format is recommended because it enables you to edit, view, and 
analyze traces with Line Sweep Tools. For more information, refer to the Line Sweep Tools 
Help file for the instrument and measurement files supported.

Procedure for saving files:

1. Press Shift then File (7).

2. Press Save Measurement.

3. Press Change Save Location and set the current location to be the USB flash drive or 
internal memory, and then press Set Location.

4. In vector network analyzer mode, press Change Type (Setup/JPG/…) and select the 
desired file type from the Select File Type list box.

5. In spectrum analyzer mode or interference analyzer mode, press one of the 4 soft keys to 
specify a file type.

6. Enter the filename by using the keyboard and then press Enter.

Refer to Chapter 4, “File Management” for more details about working with files.
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Chapter 4 — File Management

4-1 Introduction
This chapter describes the file management features of the VNA Master and describe the 
File menu. The submenus under this menu allow you to save, recall, copy, and delete files in 
internal memory or an external USB flash drive.

4-2 File Types 
Filename extensions that are used in the VNA Master:

*.jpg JPEG images, filename.jpg

*.mna Vector Network Analyzer Measurements, filename.mna

*.stp Setups, filename.stp

*.s2p S2P (SnP), filename.s2p

*.spa Spectrum Analyzer Measurements, filename.spa

*.csv Text file with Comma Separated Values (CSV), filename.csv

*.txt Text file with tab separated values, filename.txt

*.lim Limit lines, filename.lim (Limit lines are available only in Spectrum Analyzer 
mode.) 

Note

S2P is a standard ASCII text file format that is used for scattering parameters from 
a 2-Port measurement. This is a subset of SnP (where n equals the number of 
ports). An S2P file can be used as input for signal analysis.

The CSV and Text files contain setup information and final formatted data that are 
shown on the instrument display screen. This file information includes any 
post-processing that was done on the data (smoothing, trace math, time domain, 
and so forth). These files contain the data for any traces that are displayed, 
including the memory traces. They also contain the markers that are turned on 
when the file is saved. 
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4-3 Managing Files 
Press the Shift key then the File (7) key on the numeric keypad to list the File menu. Follow 
the additional steps below.

Save Files

Set the Save Location 

Press Save then the Change Save Location soft keys (submenu keys) and select the location to 
save files. You can save files to the internal memory or to an external USB flash drive. You 
can also create new folders. If an external USB flash drive is connected or disconnected, press 
Refresh Directories to update the location tree. Press the Set Location key to store the save 
location.

Save Measurement As

The Save Measurement As key is used to quickly save measurements with a specific file 
name. The VNA Master saves the measurement with the latest file name that was used to 
save a measurement and with a number that is automatically incremented and appended to 
the end of the file name. For instance, if the last measurement was saved with the name 
System Return Loss, Save Measurement As saves the next measurement as System Return 
Loss_#1, System Return Loss_#2 etc. The file name used can be changed using the Save 
dialog box (Figure 4-1).

Save a Measurement

Press the Save Measurement key and enter the name for the measurement file. The 
measurement file can be stored as .MNA.

Save a Setup 

Press the Save soft key, type a name for the setup file, confirm that the file type is Setup 
using the Change Type key or the touchscreen, and then press Enter to save. 

Create a Menu Shortcut for a Setup File

Press the Recall soft key to display saved setup files. Locate the setup file to shortcut and 
then press and hold on the file name for a few seconds. Select a location in the shortcut grid to 
save the setup file.

Save a Measurement Screen as JPEG 

Press the Save soft key, type a name for the JPEG file, confirm that the file type is Jpeg, and 
press Enter to save.

Note
When navigating through the File menu, pressing the Esc key returns to the 
previous menu.
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Save Dialog Box

The save dialog box (Figure 4-1) is used to store files on the internal memory or an external 
flash drive. The file type, file name, and save location are set starting with this display. Refer 
to “Save Menu” on page 4-9 and “Save Location Menu” on page 4-10 for details. 

Quick Name Keys 

Quick Name keys (located below the keyboard in Figure 4-1) allow you to enter quick names 
for frequently used parts of file measurement names. To edit the keys, press the Shift key, 
then the File (7) key. Press Save then the Change Quick Name key, and select one of the 
Quick Names for editing. Press Enter and enter the new name for the key. Press Enter again, 
and the new name is displayed on the Quick Name key. 

When entering filenames, use the quick name keys in any order in combination with the 
keyboard to create measurement filenames.

Figure 4-1. Save Dialog Box
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Recall Files

The recall menu enables you to view all of the Measurement and Setup files in the internal 
memory and in an external USB flash drive.

You can sort the recall menu by name, date, or type. You can also choose to view only 
measurement files or setup files by pressing File Type on the Recall dialog box and selecting 
the file type that you want to view.

Recall a Measurement

From the File menu, press the Recall Measurement soft key (submenu key), select the 
measurement with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press 
Enter. 

Recall a Setup

Press the Recall soft key. Confirm that the file type is Setup or All. Select the setup file (.stp) 
with the touchscreen, rotary knob, or the Up/Down arrow keys, and then press Enter.

Recall Dialog Box 

The Recall dialog box (Figure 4-2) opens previously saved measurements and setups. Refer 
to the “Recall Menu” on page 4-12 for additional information. 

Figure 4-2. Recall Dialog Box
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Copy Files

The steps below describe copying a file from internal memory to an external flash drive. 
Select the files to copy in the top window and the location for the files (to be copied) in the 
bottom window (Figure 4-3). Refer to the “Copy Menu” on page 4-13 for additional 
information.

1. Insert a USB drive into either USB Type A port of the VNA Master. 

2. From the File main menu, press the Copy soft key. The Copy menu and Copy dialog box 
are displayed.

3. Select the files that are to be copied. To select multiple files, highlight the first file, then 
press the Select or De-Select key to keep the file selected. The selected file is outlined in 
blue. Repeat with all the files that are to be copied. To display files in a folder, select the 
folder and press the Enter key.

4. Press the Scroll key and highlight the USB drive in the lower window using the 
touch screen or the Up/Down arrow keys. The Scroll soft key toggles between source 
and destination, Src (top window) and Dst (bottom window).

5. Press the Copy key to copy the files to the flash drive.

Figure 4-3. Copy Dialog Box
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Delete Files 

Press the Delete soft key (submenu key). Highlight the file to be deleted with the touchscreen 
or the Up/Down arrow keys. Press the Select or De-Select key. Selected files are outlined in 
blue. Press the Delete key and then press Enter to delete the selected file.

Delete Dialog Box

Press the Delete soft key to open the Delete dialog box (Figure 4-4). The menus allow sorting 
by file type, name, and saved date. Refer to the “Delete Menu” on page 4-14 for additional 
information. 

Figure 4-4. Delete Dialog Box
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4-4 File Menu Overview
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 4-5. File Menu
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4-5 File Menu  
Key Sequence: File

Save Measurement As: Press this soft key (submenu key) to save the 
current setup with a user defined filename. The default filename is changed 
using the Save menu. To change the default file name, type in a new file with 
the touch screen keyboard and press Enter. After a few seconds, the screen 
returns to File menu. Press the Save Measurement As key again and the 
new file name is used. 

Save Measurement: Press this soft key to display the “Save Menu” 
on page 4-9 and the touch screen keyboard. Measurements can be saved to 
internal memory or to a USB flash drive. The saved measurement can be 
named by using the touch screen keyboard. By default, measurements are 
saved to internal memory in a directory named /user. The save destination is 
set with the “Save Location Menu” on page 4-10.

Save: Press this soft key to display the “Save Menu” on page 4-9 and the 
touch screen keyboard. Measurements can be saved to internal memory or 
to a USB flash drive. The saved setup, measurement, or JPEG file can be 
named by using the touch screen keyboard. By default, measurements are 
saved to internal memory in a directory named /user. The save destination is 
set with the “Save Location Menu” on page 4-10.

Save on Event: Press this soft key to display the “Save On Event Menu” 
on page 4-11. This soft key is displayed only in Spectrum Analyzer and 
Interference Analyzer modes.

Recall Measurement: Press this soft key to display the “Recall Menu” 
on page 4-12. This menu is for recalling measurements from internal 
memory or from a USB flash drive.

Recall: Press this soft key to display the “Recall Menu” on page 4-12. This 
menu is for recalling measurement or setup data from internal memory or 
from a USB flash drive.

Copy: Press this soft key to display the “Copy Menu” on page 4-13. The 
Copy menu is for copying files or folders from internal memory or a USB 
flash drive.

Delete: Press this soft key to display the “Delete Menu” on page 4-14 and a 
selection box that shows the setup and measurement names and the type, 
date, and time that the information was saved. Use the rotary knob or the 
Up/Down arrow keys to highlight the file that is to be deleted and press the 
Delete soft key, then press Enter. Press the Esc key to cancel the operation. 
Note that deleted files cannot be recovered.

Figure 4-6. File Menu
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Save Menu 

The top keys in the Save menu display the available file-type save options based on the 
current measurement mode.

Key Sequence: File > Save 

Setup: Setup files contain basic instrument information, measurement mode 
setup details, measurement marker data, and limit data. File extension: .stp

Measurement: Contains the measurement data and opens up with either 
Line Sweep tools or Master Software Tools. File extension: Varies based on 
measurement.

Jpeg: Jpeg files contain a screen capture of the display. File extension: .jpg

Limit Lines: Contains limit line data details. File extension: .lim

In VNA mode, these top soft keys are not displayed, but the file-type 
choices are available by pressing the Change Type soft key, which is 
not displayed in Spectrum Analyzer or Interference Analyzer modes.

Change Quick Name: Press this soft key (submenu key) to change the 
Quick Names that are displayed at the bottom of the touch screen keyboard 
(Figure 4-1). Select the Quick Name to edit and press Enter. Type the new 
Quick Name and press Enter again. The new Quick Name is displayed on 
the corresponding Quick Name button below the keyboard.

Change Save Location: Press this soft key to open the “Save Location 
Menu”. 

Change Type Setup/JPG/... Press this soft key in VNA and VVM modes to 
select among the various file types available for setup and measurement 
data. This soft key also opens the File Type menu with a soft key to select 
Full screen or Graph Only images for JPEG file types. This soft key is not 
displayed in Spectrum Analyzer or Interference Analyzer modes

Figure 4-7. Save Menu
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Save Location Menu 

This menu and dialog box are used to create folders and to select the location where the 
VNA Master saves the current file. Select folders or drives with the Up/Down keys, the rotary 
knob, or the touch screen. 

Key Sequence: File > Save > Change Save Location 

Note
Only folders (not files) are visible in the Save Location dialog box. To view files, use 
the “Recall Menu” on page 4-12.

Sort By
Name Date type: Press this soft key (submenu key) to sort the folders by 
Name, Type, or Date. 

Sort Order
Asc Desc: Press this soft key to display the folder names in ascending or 
descending order.

Create Folder: Press this soft key to create a new folder in the highlighted 
location or folder. Name the new folder in the create directory dialog box.

Set Location: Press this soft key to set the current location for saving files 
and then return to the “Save Menu” on page 4-9.

Refresh Directories: Press this soft key to update the display.

Figure 4-8. Save Location Menu

Figure 4-9. Select Save Location Dialog Box
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Save On Event Menu 

In Spectrum Analyzer and Interference Analyzer modes, this menu is used to auto save 
measurements to internal memory after a set events occur.

Key Sequence: File > Save On Event 

...Crossing Limit
On Off: Toggling this soft key (submenu key) to On sets the VNA Master 
to save the measurement to internal memory when the measurement has 
crossed a defined limit line that has been created with the Limit menu.

...Sweep Complete
On Off: Toggling this soft key to On sets the VNA Master to save the 
measurement to internal memory after the current sweep is complete. If 
Save Then Stop is toggled Off, then a measurement is saved after every 
sweep.

Save Then Stop
On Off: Toggling this key to On sets the VNA Master to stop the sweep 
after a measurement is saved. With this key Off and Sweep Complete On, a 
measurement is saved after every sweep.

Clear All: Press this key to turn Off all three save-on-event keys:

Crossing Limit

Sweep Complete

Save Then Stop 

Back: Press this key to return to the “File Menu” on page 4-8.

Figure 4-10. Save On Menu
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Recall Menu 

This menu and its dialog box are used to select the location from which the VNA Master 
recalls a file. Select folders or drives with the Up/Down arrow keys, the rotary knob, or the 
touch screen. 

Key Sequence: File > Recall 

Sort By
Name Date Type: Press this soft key (submenu key) to sort files and 
folders by the file name, by the type of file, or by the date that the file or 
folder was saved.

Sort Order
Asc Desc: Displays the folder or file in ascending or descending order 
based on the selection in the Sort By key.

File Type: Press this soft key to select the type of file to be viewed. The file 
type can be changed with the Up/Down arrow keys, the rotary knob, or the 
touch screen. Press Enter to make the selection. Refer to Section 4-2 “File 
Types” for file type descriptions.

Refresh Directories: Press this key to update the display.

Figure 4-11. Recall Menu
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Copy Menu 

This menu and dialog box are used to copy folders and files. Select folders or files with the 
Up/Down arrow keys, the rotary knob, or the touch screen. Figure 4-3 on page 4-5 shows the 
Copy dialog box with two JPEG images and one folder (including the folder contents) selected 
and ready to be copied to the USB flash drive. Highlight a folder and press Enter to view the 
contents.

Key Sequence: File > Copy 

Sort By
Name Type Date: Press this soft key (submenu key) to sort file and 
folder lists by name, by type of file, or by the date that a file was saved.

Sort Order
Asc Desc: Press this soft key to display the folders or files in ascending 
or descending order based on the selection in the Sort By key.

File Type: Press this soft key to select the type of files to view for copying. 
The file type can be changed with the Up/Down arrow keys, the rotary 
knob, or the touch screen. Press Enter to make the selection. Refer to 
Section 4-2 “File Types” for file type descriptions.

Refresh Directories: Press this soft key to update the display. 

Scroll
Src Dst: Press this soft key to use the scroll function in the Source Folder 
(Src or top panel) or in the Destination Folder (Dst or bottom panel). Refer 
to Figure 4-3.

Select or De-Select: Press this soft key to select or deselect the files or 
folders to be copied. When selected, a file or folder is outlined in blue. Refer 
to Figure 4-3.

Copy: Press this soft key to copy the files or folders that are selected in the 
top window to the destination that is selected in the bottom window. A dialog 
box indicates when the copying is complete. If a file with the same name 
exists in the destination folder, then a warning box is displayed to allow file 
overwrite or cancel.

Figure 4-12. Copy Menu
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Delete Menu

This menu and dialog box are used to delete folders and files. Select folders or files with the 
Up/Down arrow keys, the rotary knob, or the touch screen.

Key Sequence: File > Delete 

Sort By
Name Date Type: Press this soft key (submenu key) to sort files and 
folders by name, by the type of file, or by the date that the file or folder was 
saved.

Sort Order
Asc Desc: Press this soft key to display the folders or files in ascending or 
descending order based on the selection in the Sort By key.

File Type: Press this soft key to select the type of file to be deleted. The file 
type can be changed with the Up/Down arrow keys, the rotary knob, or the 
touch screen. Press Enter to make the selection. Refer to Section 4-2 “File 
Types” for file type descriptions.

Select or De-Select: Press this soft key to select or deselect the files or 
folders to be deleted. When selected, a file or folder is outlined in blue.

Delete: Press this soft key to open the Delete dialog box. Press Enter to 
delete the selected item, or press Esc to Cancel. 

Refresh Directories: Press this soft key to update the display.

Figure 4-13. Delete Menu
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Chapter 5 — System Operations 

5-1 Introduction
This chapter describes the VNA Master system operations.

• “System Menu Group Overview” on page 5-2

• “System Menu” on page 5-3

• “Preset Menu” on page 5-11

• “Power On Self Test” on page 5-12

• “Updating the VNA Master Firmware” on page 5-12

The other menus (Sweep, Measure, Trace, and Limit) are described in the Measurement 
Guides that are listed in Appendix A.
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5-2 System Menu Group Overview  
To access the functions under the System menu, press the Shift key, then the System (8) key. 
Menu maps typically display all possible submenu keys, although some keys are displayed on 
the instruments only under special circumstances (refer to menu descriptions on the following 
pages). 

Figure 5-1. System Menu Map
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5-3 System Menu   
Key Sequence: Shift, System (8) 

Status: Press this submenu key to display the current system status, 
including the operating system and firmware versions, temperatures, and 
other details such as current battery information. Press Esc or Enter to return 
to normal operation.

Self Test: Press this submenu key to run a series of tests that are related to 
the performance of the motherboard hardware. Press the Esc key to abort, or 
press the Enter key to continue. The display lists a summary of those tests 
that have passed. If any test fails, then all of the performed tests are listed 
with Pass/Fail notification. 

If the Self Test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, then contact your Anritsu Service 
Center and report the test results. Press Esc or Enter to return to normal 
operation.

Application Self Test: Press this submenu key to run a series of tests that 
are related to the performance of the instrument hardware and that are 
specific to the current instrument application. Press the Esc key to abort, or 
press the Enter key to continue. The display lists a summary of those tests 
that have passed. If any test fails, then all of the performed tests are listed 
with Pass/Fail notification. If any test fails, then contact your Anritsu Service 
Center and report the test results.

GPS: Press this submenu key to open the GSP Menu. Refer to 
Chapter 6, “GPS (Option 31) ” for additional information.

Application Options: Submenu keys are specific to each measurement 
mode: “Application Options Menu (VNA Mode)” on page 5-6
“Application Options Menu (SPA Mode)” on page 5-7.

System Options: Press this submenu key to open the “System Options 
Menu” on page 5-4.

Figure 5-2. System Menu
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System Options Menu  

Key Sequence: Shift, System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys, or 
the rotary knob to select the date and time. Press Enter to accept the 
changes, or press the Esc key to return to normal operation without changing 
anything.

Ethernet Config: Press this submenu key to display the Ethernet submenu 
and to open the Ethernet Editor dialog box to set the IP address of the 
instrument. For details, refer to section “Ethernet Configuration” on page F-1 
in Appendix F, “LAN and DHCP”.

Language: Press this submenu key to open a list box and select a built-in 
language for the VNA Master displays. The languages that are currently 
available are: English, French, German, Spanish, Japanese, Chinese, 
Korean, and Italian. In addition, a custom language may be selected if it has 
been defined by using Master Software Tools and loaded into the 
VNA Master. Two custom languages may be loaded into the instrument via 
Master Software Tools. If a mode does not have language translations 
available, then English is the default language. Press Enter to accept the 
change, or press the Esc key to return to normal operation without changes.

In addition, any existing language (except English) may be edited for a better 
local translation.

Note: A Factory Default reset (Esc+On) will overwrite any custom settings 
within the VNA Master and will require that you reload the custom language 
files via Master Software Tools.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 5-9 allowing brightness control and the selection of the default color 
display, black & white display, night vision display, or a high contrast display.

Name: Press this submenu key to open a dialog box to name the instrument. 
The VNA Master can be named by using the text entry controls as described 
in section “Text Entry” on page 2-20. Press Enter to save the name.

Volume: Press this submenu key to set the speaker volume. The current 
volume setting is displayed on the screen. Use the keypad, the Up/Down 
arrow keys, or the rotary knob to change the volume, and press the Enter key 
to accept the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-10.

More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 5-5.

Figure 5-3. System Options Menu
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System Options 2/2 Menu    

Key Sequence: Shift, System (8) > System Options > More 

Remote Access Password       

This function is valid only with Master Software Tools (MST) v2.21.1 or later. After setting 
the password, reboot the instrument (normal power OFF then ON) to provide remote access 
security. Only one user then has access at any one time. 

The password is first set into the instrument, then used in MST. When prompted in MST, 
enter the password into the password text box. The password text box shown in Figure 5-5 
may differ from the text box that is displayed on your instrument. 

The password can be removed or reset by a Master Reset, by a Factory Default reset, or by a 
firmware update (which includes a restart).

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting to 
All Modes or to Not Shared. Select All Modes to have the current center fre-
quency setting and power offset setting carried over when changing measure-
ment modes. This function is not applicable to measurements that do not 
have a center frequency or power offset setting or to measurements in which 
the current center frequency or power offset setting is outside the range of the 
new measurement.

Note: This key is used only for spectrum analysis.

Set Remote Access Password: Press this submenu key to open the Pass-
word text box (Figure 5-5) and Text Entry menu. Type in the desired pass-
word. Upper case and lower case letters and the symbols - _ + . are the 
allowed password characters. Press Enter to save or Esc to cancel.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-4. System Options Menu 2/2) 

Warning Do not use SCPI commands with this feature.
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5-4 Application Options Menu (VNA Mode)  
Key Sequence: Shift, System (8) > Application Options 

Standard VNA menus selected.

Units
m ft: Press this soft key (submenu key) to toggle the units setting to metric 
(meters, or m) or to U.S. (feet, or ft). Press Enter to accept the changes, or 
press the Esc key to return to normal operation without changing the setting.

Trace Label
On Off: Press this soft key (submenu key) to toggle the trace labels On or 
Off.

Meas Gain Range: Press this soft key to open the “Mode (Meas Gain 
Range) Menu (VNA Mode)”. Then select Auto or Fixed. 

Trace Label
On Off: Press this submenu key to toggle between Field (a simplified 
subset of the standard VNA menu structure) and VNA (standard menu 
structure.

Back: Press this soft key to return to the “System Menu” on page 5-3.

Figure 5-6. Application Options Menu (VNA Mode)  (Sheet 1 of 2)
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5-5 Application Options Menu (SPA Mode) 
Key Sequence: Shift, System (8) > System Options > Application Options 

Field menus selected.

Units
m ft: Press this soft key (submenu key) to toggle the units setting to metric 
(meters, or m) or to U.S. (feet, or ft). Press Enter to accept the changes, or 
press the Esc key to return to normal operation without changing the setting.

Trace Label
On Off: Press this soft key (submenu key) to toggle the trace labels On or 
Off.

Trace Label
On Off: Press this submenu key to toggle between Field (a simplified 
subset of the standard VNA menu structure) and VNA (standard menu 
structure.

Bias Tee Setup: Press this soft key to open the Bias Tee menu. Refer to 
Chapter 7, “Bias Tee (Option 10) ” for more information.

Back: Press this soft key to return to the “System Menu” on page 5-3.

Impedance
50 Ohm 75 Ohm Other: Press this soft key (submenu key) to toggle the 
impedance setting to 50 ohm, 75 ohm, or Other impedance value. Selecting 
75 ohm selects the 7.5 dB loss of the Anritsu 12N50-75B adapter. For other 
adapters, select Other and enter the appropriate loss.

Back: Press this soft key to return to the “System Menu” on page 5-3.

Figure 5-7. Application Options Menu (SPA Mode)

Figure 5-6. Application Options Menu (VNA Mode)  (Sheet 2 of 2)
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5-6 Mode (Meas Gain Range) Menu (VNA Mode)   

Auto: Press this soft key to set the Measurement Gain Range Mode to Auto. 
In this mode, the instrument adjusts the gain automatically to provide the best 
overall system performance (dynamic range and high level noise). 

Fixed: Press this soft key to set the Measurement Gain Range Mode to 
Fixed. In this mode, the gain of the instrument is always set to the low gain 
setting. For most applications, Auto mode is recommended. For certain types 
of filter measurements (mostly in the range less than 500 MHz), the 
instrument may toggle between low gain and high gain modes as the signal 
level rises from the noise to the pass band of the filter, resulting in extra ripple. 
Setting the Gain Range to fixed may address that problem.

Back: Press this soft key to return to the “Application Options Menu (VNA 
Mode)”.

Figure 5-8. VNA Mode (Measurement Gain Range) Menu

Back

Auto

Fixed

Mode
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5-7 Display Settings Menu     
Key Sequence: Shift, System (8) > System Options > Display 

Brightness: Press this soft key to adjust the brightness of the display to 
optimize viewing under a wide variety of lighting conditions. Use the keypad, 
the Up/Down arrow keys or the rotary knob to select a brightness level from 
1 to 9, with 9 being the brightest. Press Enter to accept the change.

Default Colors: Press this soft key to set the display colors to their factory 
default condition. Use for normal viewing.

Black & White: Press this soft key to set the display colors to black and 
white. Use for printing and viewing in broad daylight conditions.

Night Vision: Press this soft key to set the display to a red-tinted color, which 
is optimized for night-time viewing.

High Contrast: Press this soft key to increase the contrast of the default 
display colors. Used for other challenging viewing conditions.

Invert Black & White: Press this soft key to invert the black and white colors 
to produce a white background and black graticule lines with colored traces. 
Use for viewing in broad daylight conditions and for color printing.

Back: Press this soft key to return to the “System Options Menu” 
on page 5-4.

Figure 5-9. Display Settings Menu
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5-8 Reset Menu  
Key Sequence: Shift, System (8) > System Options > Reset 

Factory Defaults: Press this soft key to restore the instrument to the factory 
default values, including language, volume, brightness setting, and user 
created shortcut icons on the Menu screen. Press the Enter key to initiate 
the reset, and power cycle the instrument.

Master Reset: In addition to the functions described in Factory Defaults 
above, all user files in the internal memory are deleted, and the original 
language and antenna files are restored. Press the Enter key to initiate the 
Master Reset and power-cycle the instrument. Press Esc to return to normal 
operation without resetting.

Update Firmware: This soft key is used for updating the instruments's 
firmware. Please refer to section x-yy System Settings, Update Firmware. 
Refer to “Updating the VNA Master Firmware” on page 5-12 for additional 
information on firmware update.

Back: Press this soft key to return to the “System Options Menu” 
on page 5-4.

Figure 5-10. Reset Menu
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5-9 Preset Menu  
Key Sequence: Shift, Preset (1) 

Preset: Press this soft key to reset the instrument to the default starting 
conditions.

Save Setup: Press this soft key to open the Save dialog box (Figure 4-1) to 
name and save the current operating settings, allowing them to be recalled 
later to return the instrument to the state it was in at the time the setup was 
saved. 

The saved setup can be named using the touch screen keyboard. Use the  
Caps key to select an upper case letter. Use the Left/Right directional 
arrows to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 4-9 for 
details.

Recall Setup: Press this soft key to select and recall a previously stored 
instrument setup using the “Recall Menu” on page 4-12. Use the rotary 
knob, the Up/Down arrow keys, or the touchscreen to highlight the saved 
setup, and press Enter. All current instrument settings are replaced by the 
stored setup information. 

Figure 5-11. Preset Menu
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5-10 Power On Self Test    
At power on, the VNA Master runs through a series of quick checks to ensure that the system 
is functioning properly.

From the “System Menu”, the System Self Test (“Self Test” on page 5-3) runs a series of tests 
that are related to the instrument itself. The Application Self Test (“Application Self Test” 
on page 5-3) runs a series of tests that are related to the current operating mode of the 
instrument. 

If the VNA Master is within the specified operating range with a charged battery, and if the 
self test fails, then contact your Anritsu Service Center (http://www.anritsu.com/Contact.asp). 

To start a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test soft key (submenu key). The Self Test results are displayed. 

3. Press Esc to continue.

5-11 Updating the VNA Master Firmware  
The VNA Master is updated using a USB memory stick. Updated product information can be 
found on the Anritsu web site:

http://www.anritsu.com 

1. Search for the product model number. The firmware updates are on the product page 
under the Library tab in the “Drivers, Software Downloads” section. Follow the 
instructions on the Download Page and during the installation process.

2. After the firmware is loaded, insert the USB memory device into the USB port of the 
instrument.

3. Press the following key sequence: Shift > System (8) > System Options > Reset > 
Update Firmware. The Load Firmware main menu key (hard key) is displayed.

4. Press the Load Firmware main menu key (hard key) to display the Firmware Update 
menu and Update Application Firmware soft key.

5. Press the Update Application Firmware soft key, and the Firmware Update dialog opens.

6. Highlight each of the save choices: Save None, Save User Data, and Save & Restore 
User Data. Read through each choice carefully and then select the desired save mode.

• Save None: No attempt is made to save any user data.

• Save User Data: User data is saved to the selected external media device. 

• Save & Restore: User data is saved to the selected external media device. The 
instrument also attempts to restore the files to the instrument after the update. 

Warning
If not enough memory space is available for all user data, then some data may be 
lost during this process.

Warning
If not enough memory space is available for all user data, then some data may be 
lost during this process.
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7. Press Enter to begin the firmware update process. To abort the process, press Esc, then 
choose another analyzer mode or power down.

8. The Firmware Update dialog will query you to confirm the process by pressing Enter to 
continue or by pressing Esc to abort.

9. Press Enter, and the firmware update process begins, and the Firmware Update dialog 
displays the following message:

Updating firmware. Please Wait. 

10. When complete, the instrument restarts.
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Chapter 6 — GPS (Option 31) 

6-1 Introduction    
The VNA Master is available with a built-in GPS receiver feature (Option 31) that can 
provide latitude, longitude, altitude, and UTC timing information. This option also enhances 
the frequency reference oscillator accuracy in the Spectrum Analyzer mode (MS203xB). 
Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of 
better than 50 ppb (parts per billion). 

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside without any obstructions. Anritsu GPS antenna 
2000-1528-R or 2000-1652-R is required.

6-2 Activating the GPS Feature
Install the Anritsu GPS antenna onto the GPS Antenna connector on the VNA Master.

1. Press the Shift key, then the System (8) key.

2. Press the GPS soft key (submenu key).

3. Press the GPS On/Off soft key to toggle the GPS feature on or off. When GPS is first 
turned on, a RED GPS icon appears at the top of the display.

Note
The VNA Master Technical Data Sheet provides a list of options and the 
measurements that require GPS (Option 31).

Figure 6-1. GPS Icon, Red

GPS
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4. When the GPS receiver has tracked at least three satellites, the GPS icon changes to 
GREEN. Latitude and Longitude information is displayed in the white bar on top of the 
display. Acquiring satellites may take as long as three minutes. 

5. Press the GPS Info soft key (submenu key) to view information about: 

• Tracked Satellites

• Latitude and Longitude

• Altitude

• UTC

• Fix Available

• Almanac Complete

• Antenna and Receiver Status

• GPS Antenna Voltage and Current

Refer to Section 6-4 “GPS Menu” on page 6-3 for details about the GPS Info dialog box.

6. Press the Reset soft key to reset the GPS.

7. The GREEN GPS icon with a RED CROSS through it, as shown below, appears when 
GPS satellite tracking is lost (after actively tracking 3 or more satellites). The GPS 
longitude and latitude are saved in the instrument memory until the VNA Master is 
turned off or until GPS is turned off by using the GPS On/Off key.

Figure 6-2. GPS Icon, Green

Figure 6-3. GPS Icon, Tracking Lost

GPS

GPS

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



GPS (Option 31) 6-3 Saving and Recalling Traces with GPS Information

MS20xxB UG PN: 10580-00301  Rev. F 6-3

6-3 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to the 
“Save Menu” on page 4-9 for more information. The current GPS coordinates are saved with 
the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, then when the measurement is 
recalled, the coordinates that were saved are recalled as well. Refer to the “Recall Menu” 
on page 4-12 for more information about recalling a saved trace.

6-4 GPS Menu 
Key Sequence: Shift, System (8) > GPS 

GPS: Press this soft key (submenu key) to turn GPS on or off.

GPS Info: Press this soft key to display the current GPS information. Refer to 
“GPS Info” on page 6-4.

GPS Voltage: Press this soft key to set the source voltage to be either 3.3 V 
or 5 V depending on the GPS receiver being used. GPS antenna voltage is 
set to 3.3 V by default in order to prevent accidental damage to lower-voltage 
GPS antennas.

Reset: Press this soft key to set the number of tracked satellites to 0 and to 
erase any almanac data, along with saved coordinates. The process of 
searching for and reacquiring satellites begins again.

Back: Press this soft key to return to the “System Menu” on page 5-3.

Figure 6-4. GPS Menu
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GPS Info

• Tracked Satellites 

Shows the number of tracked satellites (three are required to retrieve latitude and 
longitude, four are required to resolve altitude). Generally, the larger number of 
satellites tracked, the more accurate the information.

• Latitude and Longitude 

Shows location in degrees, minutes, and seconds.

• Altitude 

Shows altitude information in meters.

• UTC 

Universal Coordinated Time.

• Fix Available 

The cold start search sets are established to ensure that at least three satellites are 
acquired within the first couple of minutes. When three satellites are found, the 
receiver computes an initial fix (typically in less than two minutes). Fix Not Available 
means that the initial position has not been established.

• Almanac Complete 

The system Almanac contains information about the satellites in the constellation, 
ionospheric data, and special system messages. In a cold start, the GPS receiver does 
not have any navigation data so the receiver does not have a current almanac. A 
complete system almanac is not required to achieve a first position fix. The availability 
of the almanac, however, can significantly reduce the time to first fix.

• Antenna Status 

OK: Antenna is connected properly and antenna is working properly

Short/Open: A short or open exists between the antenna and the connection. If this 
message is displayed, then remove and replace the GPS antenna. If the message 
persists, then try another Anritsu GPS antenna (part number 2000–1528-R). If the 
message persists, then contact your nearest Anritsu Service Center.

• Receiver Status 

Current status of the receiver.

• GPS Antenna Voltage and Current 

Shows voltage and current.
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Chapter 7 — Bias Tee (Option 10) 

7-1 Overview  
The use of this option is fully described in the Vector Network Analyzer Measurement Guide 
(refer to Appendix A). Some instrument-specific information is provided in this introduction 
to Bias Tee.

Option 10 provides a bias tee that is installed inside the instrument. The bias arm is 
connected to a 12 VDC to 32 VDC power source that can be turned on as needed to place the 
voltage on the center conductor of the instrument VNA Port 2. This supply of bias implies it is 
mostly useful when conducting two-port transmission measurements. This voltage can be 
used to provide power to block down-converters in satellite receivers and can also be used to 
power some tower-mounted amplifiers.

The bias can be turned on only when the instrument is in vector network analyzer mode, and 
when the Start Frequency is 2 MHz or greater. When bias is turned on, the bias voltage and 
current are displayed in the Instrument Settings Summary area at the top-left corner of the 
sweep window. The 12 VDC to 32 VDC power supply is designed to continuously deliver a 
maximum of 6 watts.

The bias tee menu can be accessed in several ways depending on how the instrument is 
configured:

• From the Sweep menu when in standard VNA Mode:

Key Sequence: Sweep > Configure Ports > Bias Tee Setup

• From the System Options menu when VNA Field menus are selected:

Key Sequence: Shift, System (8) > Application Options > Bias Tee Setup

• From the System Options menu when in Spectrum Analyzer mode:

Key Sequence: Shift, System (8) > Application Options > Bias Tee
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Figure 7-1 shows how the MS20xxB can provide an internal voltage between 12 volts and 
32 volts that is applied to the center conductor of Port 2. That voltage would be available at 
the port along with the RF signals. 

Figure 7-1. Internal Bias
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Chapter 8 — Anritsu PC Software 
Tools

8-1 Introduction
This chapter provides a brief overview of the available PC software tools from Anritsu. For 
detailed information about specific software, refer to the Anritsu web site or the program’s 
built-in Help. Software is included with the instrument and is also available from the Anritsu 
web site: http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx.

8-2 Anritsu Tool Box
The Anritsu Tool Box is a central location to open an Anritsu measurement, visit the 
Anritsu web site, or launch several Anritsu applications. To open the Anritsu Tool Box, either 
click on the shortcut icon on the desktop or click Start and navigate through the Programs 
folder to the Anritsu folder and select Anritsu Tool Box. 

Once the Tool Box is open, move the mouse pointer over any of the application icons to view a 
short description of the application. The following pages describe three software programs 
that can be launched from the Tool Box, Line Sweep Tools, Master Software Tools (MST), and 
easyMap Tools™.

Figure 8-1. Anritsu Tool Box
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8-3 Line Sweep Tools
Line Sweep Tools is a program designed to increase productivity for people who work with 
dozens of Cable traces, Antenna traces, and Passive Intermodulation (PIM) traces every day. 
Line Sweep Tools will:

• Collect sweeps from Anritsu PIM and Line Sweep gear.

• Help verify that those sweeps are done properly and that the Cable, Antenna and PIM 
sweeps meet specifications.

• Help create reports of the findings quickly and to a professional standard.

Note

The Anritsu PC Software tools do not support all of Anritsu’s handheld instruments 
or all of their measurements. Compatibility information is provided in the program’s 
Help.

Line Sweep Tools (LST) can be used for downloading and post-processing of 
certain VNA measurements and cable & antenna analysis sweeps.

Master Software Tools (MST) is primarily used for spectrum analysis 
measurements. 

Figure 8-2. Line Sweep Tools
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8-4 Master Software Tools
Anritsu Master Software Tools is a PC program for transferring and editing saved 
measurements, markers, and limit lines to a PC. MST is recommended for Spectrum 
Analyzer instruments or instruments that perform spectrum analysis measurements. 

Figure 8-3. Master Software Tools 

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



8-5 easyMap Tools Anritsu PC Software Tools

8-4 PN: 10580-00301  Rev. F MS20xxB UG

8-5 easyMap Tools
easyMap Tools creates geo-referenced maps and can also convert floor plans for use by 
Anritsu mapping spectrum analyzers. It can also create single panel maps (.map) for legacy 
instruments or pan and zoom maps (.azm) for current instruments. Mapping of both 
interference and coverage is available while indoors or outdoors.

Figure 8-4. Captured Geo-referenced Map Ready for the Analyzer
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Appendix A — Supplemental 
Documentation

A-1 Introduction 
This appendix provides a list of supplemental documentation and software associated with 
this User Guide. The measurement guides are available as PDF files on the document disc 
that is provided with the instrument. Updated documents are available from the Anritsu Web 
site. The Web site also has links to download application notes, brochures, and online help.

A complete suite of computer software applications are available for download: 

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

Table A-1. Measurement Guides for Analyzers and Analyzer Options

VNA Master Feature (Available Option)
Document and
Part Number

Vector Network Analyzer 
Bias-Tee (0010)
Vector Voltmeter (0015)
Distance Domain (0501)

Vector Network Analyzer 
Measurement Guide (10580-00289)

High-Accuracy Power Meter (0019) Power Meter Measurement Guide 
(10580-00240)

Spectrum Analyzer
Interference Analyzer (0025)
Channel Scanner (0027)
Coverage Mapping (0431)
AM/FM/PM Analyzer (0509)

Spectrum Analyzer Measurement Guide 
(10580-00244)

Table A-2. VNA Master Related Documents

VNA Master Related Documents Related Document and Part Number

Performance Specifications VNA Master Technical Data Sheet 
(11410-00549)

SCPI Programming Manual VNA Master Programming Manual 
(10580-00302)
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Appendix B — Signal Standards

B-1 Introduction
This appendix provides a sample list of signal standards. This list can be used as a reference 
when making measurements with the VNA Master. 

Table B-1. Signal Standards

Signal Standard
Center 
(MHz)

Span 
(MHz)

Valid Channels

AMPS / EIA 553 - Uplink 859 70 1-799, 990-1023

AMPS / EIA 553 - Downlink 859 70 1-799, 990-1023

C-450 (P) - Uplink 463.5 21 1-800

C-450 (P) - Downlink 463.5 21 1-800

C-450 (SA) - Uplink 462.5 15 1-247

C-450 (SA) - Downlink 462.5 15 1-247

CDMA US Cellular - Uplink 859 70 1-799, 990-1023

CDMA US Cellular - Downlink 859 70 1-799, 990-1023

CDMA US PCS - Uplink 1920 140 1-1199

CDMA US PCS - Downlink 1920 140 1-1199

CDMA Korea PCS - Uplink 1810 120 1-599

CDMA Korea PCS - Downlink 1810 120 1-599

CDMA Japan / ARIB - Uplink 878.5 93 1-799, 801-1039, 1041-1199

CDMA Japan / ARIB - Downlink 878.5 93 1-799, 801-1039, 1041-1199

CDMA China - 1 - Uplink 916 88 0-1000, 1329-2047

CDMA China - 1 - Downlink 916 88 0-1000, 1329-2047

CDMA China - 2 - Uplink 910 76 0-1000

CDMA China - 2 - Downlink 910 76 0-1000

cdma2000 Class 0, Korea Cellular - Uplink 859 70 1-799, 990-1023

cdma2000 Class 0, Korea Cellular - Downlink 859 70 1-799, 990-1023

cdma2000 Class 0, N.A. Cellular - Uplink 859 70 1-799, 990-1023

cdma2000 Class 0, N.A. Cellular - Downlink 859 70 1-799, 990-1023

cdma2000 Class 1, N.A. PCS - Uplink 1920 140 0-1199

cdma2000 Class 1, N.A. PCS - Downlink 1920 140 0-1199

cdma2000 Class 2, (TACS Band) - Uplink 916 88 0-1100, 1329-2047

cdma2000 Class 2, (TACS Band) - Downlink 916 88 0-1100, 1329-2047

cdma2000 Class 3, (JTACS Band) - Uplink 878.5 93 1-799, 801-1039, 1041-1199

cdma2000 Class 3, (JTACS Band) - Downlink 878.5 93 1-799, 801-1039, 1041-1199

cdma2000 Class 4, Korea PCS - Uplink 1810 120 0-599

cdma2000 Class 4, Korea PCS - Downlink 1810 120 0-599

cdma2000 Class 5, (NMT-450-20 kHz) - Uplink 472.5 43 1039-1473, 1792-2016
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cdma2000 Class 5, (NMT-450-20 kHz) - 
Downlink

472.5 43
1039-1473, 1792-2016

cdma2000 Class 5, (NMT-450-25 kHz) - Uplink 439.5 57 1-300, 539-871

cdma2000 Class 5, (NMT-450-25 kHz) - 
Downlink

439.5 57
1-300, 539-871

cdma2000 Class 6, IMT-2000 - Uplink 2045 250 0-1199

cdma2000 Class 6, IMT-2000 - Downlink 2045 250 0-1199

cdma2000 Class 7, N.A. 700 MHz Cellular - 
Uplink

770 48
0-359

cdma2000 Class 7, N.A. 700 MHz Cellular - 
Downlink

770 48
0-359

ETACS - Uplink 916 88 0-1000, 1329-2047

ETACS - Downlink 916 88 0-1000, 1329-2047

GSM 900 - Uplink 897.4 40 1-124, 975-1023

GSM 900 - Downlink 942.4 40 1-124, 975-1023

GSM 1800 - Uplink 1747.4 80 512-885

GSM 1800 - Downlink 1842.4 80 512-885

GSM 1900 - Uplink 1879.8 80 512-810

GSM 1900 - Downlink 1959.8 80 512-810

JTACS - Uplink 878.5 93 0-1198 (even numbers only)

JTACS - Downlink 878.5 93 0-1198 (even numbers only)

MATS-E - Uplink 925 70 1-1000

MATS-E - Downlink 925 70 1-1000

N-AMPS / IS-88L - Uplink 859 70 1-799, 990-1023

N-AMPS / IS-88L - Downlink 859 70 1-799, 990-1023

N-AMPS / IS-88M - Uplink 859 70 1-799, 990-1023

N-AMPS / IS-88M - Downlink 859 70 1-799, 990-1023

N-AMPS / IS-88U - Uplink 897.5 147 1-799, 990-1023

N-AMPS / IS-88U - Downlink 897.5 147 1-799, 990-1023

NADC IS136 Cellular - Uplink 859 70 1-799, 990-1023

NADC IS136 Cellular - Downlink 859 70 1-799, 990-1023

NADC IS136 PCS - Uplink 1920 140 1-1199

NADC IS136 PCS - Downlink 1920 140 1-1199

NMT-411-25 kHz - Uplink 420.5 19 539-871

NMT-411-25 kHz - Downlink 420.5 19 539-871

NMT-450-20 kHz - Uplink 460.5 19 1039-1473

NMT-450-20 kHz - Downlink 460.5 19 1039-1473

NMT-450-25 kHz - Uplink 459 18 1-300

Table B-1. Signal Standards

Signal Standard
Center 
(MHz)

Span 
(MHz)

Valid Channels
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NMT-450-25 kHz - Downlink 459 18 1-300

NMT-470-20 kHz - Uplink 486.5 15 1972-2016

NMT-470-20 kHz - Downlink 486.5 15 1972-2016

NMT-900 - Uplink 925 70 1-1000

NMT-900 - Downlink 925 70 1-1000

NMT-900 (Offset) - Uplink 925 70 1025-2023

NMT-900 (Offset) - Downlink 925 70 1025-2023

NTACS - Uplink 878.5 93 1-1199

NTACS - Downlink 878.5 93 1-1199

PDC 800 Analog - Uplink 891.5 97 0-1680

PDC 800 Analog - Downlink 891.5 97 0-1680

PDC 1500 (JDC) - Uplink 1513 72 0-960

PDC 1500 (JDC) - Downlink 1513 72 0-960

PHS - Uplink 1906.5 23 1-77

PHS - Downlink 1906.5 23 1-77

SMR 800 - 12.5 kHz - Uplink 836 60 1-1199

SMR 800 - 12.5 kHz - Downlink 836 60 1-1199

SMR 800 - 25 kHz - Uplink 836 60 1-600

SMR 800 - 25 kHz - Downlink 836 60 1-600

SMR 1500 - Uplink 1483 60 1-479

SMR 1500 - Downlink 1483 60 1-479

TACS - Uplink 925 70 1-1000

TACS - Downlink 925 70 1-1000

UMTS/WCDMA - Uplink 1920 70 9600-9900

UMTS/WCDMA - Downlink 2110 70 10550-10850

UMTS/Region 2 - Uplink 1850 70 9250-9550

UMTS/Region 2 - Downlink 1930 70 9650-9950

802.11a 5170 84 34-161 (not all valid)

802.11b 2442 84 1-14

802.11 DS 2448 72 1-14

802.11 FH 2448.5 93 2-95

802.11g 2442 84 1-14

Table B-1. Signal Standards

Signal Standard
Center 
(MHz)

Span 
(MHz)

Valid Channels
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Appendix C — Error Messages

C-1 Introduction
This appendix provides a list of information and error messages that could be displayed on 
the VNA Master. If any error condition persists, then contact your local Anritsu Service 
Center. 

C-2 Reset Options
You can reset your VNA Master to Factory Defaults or use a Master Reset to return to the 
FULL Factory Default condition from the menu system or from the Off condition.

Reset Via Instrument Menus

From the VNA Master menu system, press the Shift key, then the System (8) key to open the 
System menu. Then press the System Options soft key to open the System Options menu. 
Then press the Reset soft key to open the Reset menu (refer to section “Reset Menu” 
on page 5-10). From the Reset menu, press either the Factory Defaults soft key or the 
Master Reset soft key. 

Reset from OFF Condition

You can also reset the VNA Master by turning it Off and then restarting under one of the 
following conditions:

Factory Defaults Reset:

Hold the Esc button while pressing the On/Off button. Continue holding the Esc button until 
the Anritsu splash screen appears. You can then release the button. The VNA Master starts 
up with many Factory Default settings (refer to section “Factory Defaults” on page 5-10). 
Throughout this appendix, this sequence is abbreviated as Factory Defaults (Esc+On).

Master Reset:

Hold the 8 key in the number keypad (also referred to as the System (8) key) while pressing 
the On/Off button. Continue holding the 8 key until the Anritsu splash screen appears. You 
can then release the key. The VNA Master starts up in FULL Factory Default condition (refer 
to section “Master Reset” on page 5-10). Throughout this appendix, this sequence is 
abbreviated as Master Reset (System+On).

C-3 Self Test or Application Self Test Error Messages

Self Test

To run self test, press Shift and System (8) and then Self Test. Refer to the results window in 
Figure C-1, which summarizes the status of several key functions in the instrument that are 
common to all applications (note that your instrument display may differ from this image). If 
any subtest shows FAILED, then check that the battery level is adequate for operation, or 
check that the temperature is within acceptable limits. Reset to factory defaults with either 
Factory Defaults (Esc+On), or Master Reset (System+On).
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Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the VNA Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.

Figure C-1. Self Test Results Window (Vector Network Analyzer mode)
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Application Self Test Results Window — VNA 

Application Self Test (Vector Network Analyzer mode only)

To run the application self test, press Shift and System (8) and then Application Self Test from 
within the desired mode. When you are in Vector Network Analyzer mode, you will see the 
results window that is shown in Figure C-2 (note that your instrument display may differ 
from this image), which summarizes the status of several key functions that are specific to 
this application. 

If the Overall Status shows Failed, then one or more elements of the Application Self Test 
have failed. This self test consists of 4 subtests:

Power Supply Test: Lists any power supply voltages that are not meeting tolerance 
specification

VCO Calibration: Lists any frequency range over which the VCO calibration is failing

Frequency Sweep: Lists any frequency range over which errors in the sweep are occurring

EEPROM: Indicates whether reading or writing (or both) to the EPPROM has failed

Figure C-2. Application Self Test Results Window (Vector Network Analyzer mode)
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If any of the subtests shows FAILED, then check that the battery level is adequate for 
operation or that temperature is within acceptable limits. Reset to factory defaults with 
either Factory Defaults (Esc+On), or Master Reset (System+On). 

Application Self Test Results Window — SPA 

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the VNA Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.

Figure C-3. Application Self Test Results Window (Spectrum Analyzer mode)
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C-4 Operation Error Messages

Fan Failure

The system has determined that the fan should be running due to the internal temperature of 
the unit, but cannot detect that the fan is actually running. 

It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan 
will vary the speed in relation to the internal temperature of the instrument (refer to 
Figure C-4). The fan will turn on at low speed when the internal temperature of the 
instrument reaches 44ºC, and will increase the fan speed to maximum at 54ºC. As the 
internal temperature of the instrument decreases, the fan will reduce speed until the 
temperature reaches 39ºC, at which point the fan will turn off.

High Temp Warning

The internal temperature has reached an excessive level, 85ºC. Verify that the ventilation 
openings are unobstructed and that the fan is running. Internal temperatures may be 
manually verified by using the SELF TEST function. Turn off the unit and allow the 
temperature to cool down. If the fault is not resolved and the internal temperature reaches 
90ºC, then a countdown of 10 seconds will begin. The countdown gives the user a chance to 
save the current setup before the instrument turns itself off (before internal temperatures 
can cause any damage). If the error persists after removing any obstructions and allowing the 
unit to cool, then reset to the factory defaults with Factory Defaults (Esc+On), or 
Master Reset (System+On). 

Operation not Permitted in Recall Mode

Attempted to perform an operation on a recalled trace. Many operations are valid only on a 
live or active trace.

Figure C-4.  Fan Speed vs. Temperature

Caution 
Use of Master Reset (System+On), will erase all user saved setups and 
measurement traces and will return the VNA Master to a full Factory Default 
condition. If the error persists, then contact your Anritsu Service Center.
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PMON PLD Fail

Unable to communicate with the Power Monitor PCBA.

Power Supply 

Power Supply failed. Charge the battery.

Error Saving File. General Error Saving File 

An error was detected while saving a file. Try again. 

C-5 Vector Network Analyzer Specific Warning Messages

Bias Tee cannot be enabled for start freq < 2MHz.

Adjust frequency before turning On the Bias Tee. 

The start frequency cannot be set less than 2 MHz when the internal or external Bias Tee is 
turned On. Set the frequency to a value larger than or equal to 2 MHz, and then turn on the 
Bias Tee.

Bias Tee is not allowed for start freq < 2MHz. 

Turn Off Bias Tee before changing the freq. 

The internal or external Bias Tee cannot be turned on when the start frequency is set to less 
than 2 MHz. Turn off the Bias Tee, and then adjust the start frequency to the desired value 
less than 2 MHz.

Changing Source Power 

Changing Source Power will affect the accuracy of the current calibration.

While Cal Correction is turned On, changing the source power level will affect the accuracy of 
the current calibration. The correction will remain On and can be used, but an indicator (?P) 
will appear next to the left-hand status column (CAL: ON) to note that the current power 
setting is different from the one used during the calibration processes. 

No valid calibration to change correction.

There is no valid calibration in volatile memory that can be used to turn Cal Correction On. A 
new calibration must be performed. 

Cannot continue with calculating. 

Cannot continue with calculating. Not all required cal steps are completed. 

When performing a calibration, you must complete all of the required steps before applying 
the “Calculate and Finish Cal” step.
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Bias Tee state cannot be changed during calibration.

While performing a calibration, and before completing all of the calibration steps, you cannot 
turn on the Bias Tee. You must wait till after all of the calibration steps are complete before 
turning on the Bias Tee. This precaution is enforced to protect the calibration components 
from getting damaged by the Bias Tee current.

Turning Bias Tee to OFF.

Bias Tee is turned on when a new calibration sequence is started. The Bias Tee is turned off 
to protect the calibration components. After all the calibration steps are completed, you can 
turn the Bias Tee back on as required.

Turning Bias Tee to OFF. 

Turning Bias Tee to OFF. Recalling measurement does not match with current setup.

The recalled setup or measurement file does not match the current setup. To ensure DUT 
safety, the Bias Tee function is turned off.

Calibration will be lost after change. 

Calibration will be lost after change. Press the button again to continue.

While performing a calibration, and before completing all the calibration steps, if you change 
any of the frequency parameters (start, stop, center, span) or the number of points, then the 
calibration must be invalidated. 

Changes not allowed during calibration. 

Changes not allowed during calibration. Press Esc to abort calibration.

Certain parameters (such as frequency and number of points) can be changed while the 
calibration process is underway. Changing these parameters is not allowed unless the 
calibration is aborted first.

Option 10 (Bias Tee) not enabled.

To turn on the internal or external Bias Tee, Option 10 must be enabled in the instrument. 
Contact your Anritsu Service Center to inquire about enabling this option.

No External Reference signal detected.

External Reference was switched to 10 MHz but no external 10 MHz signal was detected. The 
External Reference setting is turned back to Off. Check the external reference level and 
frequency, and then try again.

Limit is not available for this Graph type.

Limits are supported only for rectilinear graph types (not for Smith Charts, for example).

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



C-5 Vector Network Analyzer Specific Warning Messages Error Messages

C-8 PN: 10580-00301  Rev. F MS20xxB UG

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



MS20xxB UG PN: 10580-00301  Rev. F D-1

Appendix D — Tower Mounted 
Amplifiers

D-1 Introduction  
A Tower Mounted Amplifier (TMA) can be used to amplify the received signal. There are 
different types of TMA depending on the system requirements. Three commonly used types 
are:

• TMA-D - A duplex tower mounted amplifier that combines transmit and receive 
ports from the radio system and connects to a single antenna. This configuration 
is specific to systems that use a single antenna configuration.

• TMA-S - A receive-only tower mounted amplifier is installed between the 
receiving antenna and the radio to boost weak signals. This configuration is 
common on systems that implement separate antennas for transmitting and 
receiving.

• TMA-DD - A dual-duplex tower mounted amplifier used for radios systems with a 
single transmission line connection for transmit and receive. These systems are 
commonly called transceivers.

Figure D-1. Tower Mounted Amplifiers
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Appendix E — Coaxial Cable 
Technical Data

E-1 Coaxial Cable Technical Data
The table below provides a sample list of common coaxial cables. Your instrument cable list 
may be different.

Table E-1. Coaxial Cable Technical Data  (Sheet 1 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3

Andrew FSJ1-50A (6 GHz) 0.84 1000 0.196 2500 0.313 6000 0.532

Andrew FSJ2-50 (6 GHz) 0.83 1000 0.133 2500 0.223 6000 0.374

Andrew FSJ4-50B (6 GHz) 0.81 1000 0.118 2500 0.201 6000 0.348

Andrew EFX2-50 (6 GHz) 0.85 1000 0.121 2500 0.202 6000 0.341

Andrew LDF1-50 (6 GHz) 0.86 6000 0.306 6000 0.306 6000 0.306

Andrew LDF2-50 (6 GHz) 0.88 6000 0.323 6000 0.323 6000 0.323

Andrew LDF4-50A (6 GHz) 0.88 1000 0.073 2500 0.121 6000 0.218

Andrew HJ4-50 (6 GHz) 0.914 1000 0.092 2500 0.156 6000 0.257

Andrew HJ4.5-50 (6 GHz) 0.92 1000 0.054 2500 0.089 6000 0.148

Andrew AVA5-50 7/8 0.91 1000 0.038 2000 0.055 2500 0.063

Andrew AVA7-50 1-5/8 0.92 1000 0.022 2000 0.034 2500 0.038

Andrew EFX2-50 0.85 1000 0.121 2000 0.177 2500 0.202

Andrew FLC 12-50J 0.88 1000 0.075 2000 0.11 2500 0.134

Andrew FLC 38-50J 0.88 1000 0.115 2000 0.169 2500 0.19

Andrew FLC 78-50J 0.88 1000 0.041 2000 0.061 2500 0.072

Andrew FLC 114-50J 0.88 1000 0.033 2000 0.05 2500 0.059

Andrew FLC 158-50J 0.88 1000 0.025 2000 0.038 2500 0.042

Andrew FSJ1-50A 0.84 1000 0.196 2000 0.285 2500 0.313

Andrew FSJ2-50 0.83 1000 0.133 2000 0.196 2500 0.223

Andrew FSJ4-50B 0.81 1000 0.118 2000 0.176 2500 0.201

Andrew HJ4-50 0.91 1000 0.092 2000 0.137 2500 0.156

Andrew HJ4.5-50 0.92 1000 0.054 2000 0.079 2500 0.089

Andrew HJ5-50 0.916 1000 0.042 2000 0.063 2500 0.071

Andrew HJ7-50A 0.921 1000 0.023 2000 0.034 2500 0.039

Andrew HJ12-50 0.931 1000 0.019 2000 0.029 2000 0.029

Andrew HL4RP-50A 0.88 1000 0.074 2000 0.109 2500 0.123

Andrew LDF4-50A 0.88 1000 0.073 2000 0.107 2500 0.12
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Andrew LDF4.5-50 0.89 1000 0.054 2000 0.08 2500 0.091

Andrew LDF5-50A 0.89 1000 0.041 2000 0.061 2500 0.07

Andrew LDF5-50B 0.91 1000 0.041 2000 0.061 2500 0.07

Andrew LDF6-50 0.89 1000 0.028 2000 0.042 2500 0.048

Andrew LDF7-50A 0.88 1000 0.024 2000 0.037 2500 0.043

Andrew LDF12-50 0.88 1000 0.021 2000 0.033 2000 0.033

Andrew VXL5-50 7/8 0.88 1000 0.045 2000 0.066 2500 0.075

Andrew VXL6-50 1-1/4 0.88 1000 0.032 2000 0.048 2500 0.055

Andrew VXL7-50 1-5/8 0.88 1000 0.024 2000 0.037 2500 0.043

Belden RG-8/8A 0.86 1000 0.132 2000 0.33 2500 0.22

Belden RG-9/9A 0.659 1000 0.289 1000 0.289 1000 0.289

Belden RG-17/17A 0.659 1000 0.18 1000 0.18 1000 0.18

Belden RG-55/55A/55B 0.659 1000 0.541 1000 0.541 1000 0.541

Belden RG-58/58B 0.77 1000 0.356 2000 0.528 2500 0.6

Belden RG-58A/58C 0.73 1000 0.594 1000 0.594 1000 0.594

Belden RG-142 0.7 1000 0.43 2000 0.663 2500 0.713

Belden RG-174 0.66 1000 1.115 1000 1.115 1000 1.115

Belden RG-178B 0.695 1000 1.509 1000 1.509 1000 1.509

Belden RG-188 0.69 1000 0.951 1000 0.951 1000 0.951

Belden RG-213 0.66 1000 0.262 1000 0.269 1000 0.269

Belden RG-214 0.659 1000 0.229 1000 0.292 1000 0.292

Belden RG-223 0.66 1000 0.476 1000 0.478 1000 0.478

Cablewave HCC 12-50J 0.915 1000 0.087 2000 0.126 2500 0.137

Cablewave HCC 78-50J 0.915 1000 0.041 2000 0.061 2500 0.066

Cablewave HCC 158-50J 0.95 1000 0.022 2000 0.031 2500 0.033

Cablewave HCC 300-50J 0.96 1000 0.015 1000 0.015 1000 0.015

Cablewave HCC 312-50J 0.96 1000 0.013 1000 0.013 1000 0.013

Cablewave HF 4 1/8 Cu2Y 0.97 1000 0.01 1000 0.01 1000 0.01

Cablewave HF 5 Cu2Y 0.96 1000 0.007 1000 0.007 1000 0.007

Cablewave HF 6 1/8 Cu2Y 0.97 1000 0.006 1000 0.006 1000 0.006

Cellflex LCF78-50JA 0.9 1000 0.039 2000 0.058 2500 0.066

Cellflex LCFS114-50JA 0.9 1000 0.029 2000 0.044 2500 0.051

Cellflex LCF158-50JA 0.9 1000 0.024 2000 0.036 2500 0.042

Cellflex LCF214-50JA 0.88 1000 0.021 2000 0.033 2000 0.033

Cellflex UCF114-50JA 0.89 1000 0.031 2000 0.047 2000 0.047

Table E-1. Coaxial Cable Technical Data  (Sheet 2 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Comscope CR50 540PE 0.88 1000 0.069 2000 0.103 2500 0.116

Comscope CR50 1070PE 0.88 1000 0.037 2000 0.055 2500 0.064

Comscope CR50 1873PE 0.88 1000 0.022 2000 0.034 2500 0.04

Eupen EC4-50-HF 1/2 0.82 1000 0.108 2000 0.161 2500 0.183

Eupen EC4-50 1/2 0.88 1000 0.074 2000 0.109 2500 0.121

Eupen EC4.5-50 5/8 0.88 1000 0.056 2000 0.083 2500 0.094

Eupen EC5-50 7/8 0.88 1000 0.04 2000 0.058 2500 0.066

Eupen EC6-50 1-1/4 0.88 1000 0.028 2000 0.043 2500 0.048

Eupen EC7-50 1-5/8 0.88 1000 0.024 2000 0.037 2500 0.042

Eupen EC7-50A 1-5/8 0.89 1000 0.023 2000 0.035 2500 0.039

Eupen EC12-50 2-1/4 0.88 1000 0.022 2000 0.034 2500 0.039

Nk Cables RF1/2-50 0.88 1000 0.073 2000 0.107 2500 0.127

Nk Cables RF1/2-50GHF 0.88 1000 0.073 2000 0.107 2500 0.127

Nk Cables RF1/2-50BHF 0.88 1000 0.073 2000 0.107 2500 0.127

Nk Cables RF5/8-50 0.88 1000 0.051 2000 0.075 2500 0.087

Nk Cables RF5/8-50GHF 0.88 1000 0.051 2000 0.075 2500 0.087

Nk Cables RF5/8-50BHF 0.88 1000 0.051 2000 0.075 2500 0.087

Nk Cables RF7/8-50 0.88 1000 0.04 2000 0.059 2500 0.07

Nk Cables RF7/8-50GHF 0.88 1000 0.04 2000 0.059 2500 0.07

Nk Cables RF7/8-50BHF 0.88 1000 0.04 2000 0.059 2500 0.07

Nk Cables RF1 5/8-50 0.88 1000 0.024 2000 0.036 2500 0.042

Nk Cables RF1 5/8-50GHF 0.88 1000 0.024 2000 0.036 2500 0.042

Nk Cables RF1 5/8-50BHF 0.88 1000 0.024 2000 0.036 2500 0.042

Nk Cables RF2 1/4-50 0.88 1000 0.021 2000 0.032 2500 0.041

Nk Cables RF2 1/4-50GHF 0.88 1000 0.021 2000 0.032 2500 0.041

Nk Cables RF2 1/4-50BHF 0.88 1000 0.021 2000 0.032 2500 0.041

Nk Cables RFF3/8-50 0.81 1000 0.147 2000 0.218 2500 0.25

Nk Cables RFF3/8-50GHF 0.81 1000 0.147 2000 0.218 2500 0.25

Nk Cables RFF3/8-50BHF 0.81 1000 0.147 2000 0.218 2500 0.25

Nk Cables RFF1/2-50 0.82 1000 0.112 2000 0.167 2500 0.19

Nk Cables RFF1/2-50GHF 0.82 1000 0.112 2000 0.167 2500 0.19

Nk Cables RFF1/2-50BHF 0.82 1000 0.112 2000 0.167 2500 0.19

Nk Cables RFF7/8-50 0.88 1000 0.04 2000 0.066 2500 0.076

Nk Cables RFF7/8-50GHF 0.88 1000 0.04 2000 0.066 2500 0.076

Nk Cables RFF7/8-50BHF 0.88 1000 0.04 2000 0.066 2500 0.076

Table E-1. Coaxial Cable Technical Data  (Sheet 3 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Times LMR100 0.66 1000 0.789 2000 1.15 2500 1.31

Times LMR200 0.83 1000 0.342 2000 0.49 2500 0.554

Times LMR240 0.84 1000 0.261 2000 0.377 2500 0.424

Times LMR400 0.85 1000 0.135 2000 0.196 2500 0.222

Times LMR500 0.86 1000 0.109 2000 0.159 2500 0.18

Times LMR600 0.87 1000 0.087 2000 0.128 2500 0.145

Times LMR900 0.87 1000 0.059 2000 0.086 2500 0.098

Times LMR1200 0.88 1000 0.044 2000 0.065 2500 0.074

Times LMR1700 0.89 1000 0.033 2000 0.049 2500 0.057

 310801 0.821 1000 0.115 1000 0.115 1000 0.115

 311201 0.82 1000 0.18 1000 0.18 1000 0.18

 311501 0.8 1000 0.23 1000 0.23 1000 0.23

 311601 0.8 1000 0.262 1000 0.262 1000 0.262

 311901 0.8 1000 0.377 1000 0.377 1000 0.377

 352001 0.8 1000 0.377 1000 0.377 1000 0.377

Table E-1. Coaxial Cable Technical Data  (Sheet 4 of 4)

Manufacturer Cable
Prop. 
Vel.

Freq
1

Loss
1

Freq
2

Loss
2

Freq
3

Loss
3
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Appendix F — LAN and DHCP

F-1 Introduction
This appendix describes network connections made available with Option 411 for the VNA 
Master. The LAN connection utilizes Ethernet configuration.

DHCP stands for Dynamic Host Configuration Protocol. This protocol allows a server to 
dynamically assign IP addresses to devices that are connected to the network. Most networks 
include a DHCP server to manage IP addresses. When a DHCP server is available on the 
network, DHCP is the preferred IP address mode.

F-2 Ethernet Configuration

LAN Connection 

The RJ-45 connector is used to connect the VNA Master to a local area network. Integrated 
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN 
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to 
show that LAN traffic is present. The instrument IP address is set by pressing the Shift key, 
then the System (8) key followed by the System Options submenu key and the Ethernet Config 
submenu key. The instrument Ethernet address can be set automatically using DHCP, or 
manually by entering the desired IP address, gateway address, and subnet mask. 

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP, and is the most common method 
of configuring a device for network use. To determine if a network is set up for DHCP, connect 
the MS20xxB to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the VNA Master off, and then on. If the network is set up for DHCP, then the assigned 
IP address should be displayed briefly after the power up sequence.

Note

An active Ethernet cable must be connected to the instrument before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address.

Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable.

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the instrument before cycling the power OFF and back ON.
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To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options submenu key and the Ethernet Config submenu key. The IP address 
will be displayed as shown in Figure F-1. The image on the display panel of your VNA Master 
may differ from the image shown here. 

Figure F-1. IP Address Assigned Using DHCP
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Ethernet Config 

Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor 
dialog box in order to set the IP address of the instrument. 

Figure F-2. Setting IP Address Manually
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Ethernet Menu  

Key Sequence: Shift, System (8) > System Options > Ethernet Config 

Type
Manual DHCP: Press this submenu key to select whether the address will 
be entered manually, or will be supplied automatically by a network DHCP 
server. If Manual is selected, then use the submenu keys or the Left/Right 
arrow keys to select the field that is to be modified. Use the keypad, the 
Up/Down arrow keys, or the rotary knob to enter the input. Press Enter to 
accept the changes, or press the Esc key to return to normal operation with-
out changing anything.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet Pro-
tocol Property to be edited.

First Octet: Moves the cursor to the left most column of the selected IP prop-
erties field.

Second Octet: Moves the cursor to the second column from the left of the 
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the 
selected IP properties field.

Fourth Octet: Moves the cursor to the forth column from the left of the 
selected IP properties field.

Figure F-3. Ethernet Menu

Ethernet

Type

Manual         DHCP

Field

IP     G-Way    Sub

First Octet

Second Octet

Third Octet

Fouth Octet
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F-3 Using DHCP
When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic 
IP operation, the assigned IP address may change from use to use. The DHCP server assigns 
IP addresses on a time rotation basis. As soon as the device is disconnected from the network, 
the IP address that it was using becomes available to lease to the next unit requesting an IP 
address. Normally, some amount of lag time occurs on the DHCP server end, so if the device 
is connected again reasonably soon, it may receive the same address.

F-4 Static IP Address
When a DHCP server is not available, a Static IP address can be used. A Static IP address is 
a fixed address. After being set, it will always remain the same, and care must be taken to 
avoid conflict with other equipment on the network.

When using a static IP address on an established network, always request a Static IP address 
from the network administrator. Randomly choosing a Static IP address on an established 
network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a Static IP address:

IP Address

This is the Static IP address on the network.

Default Gateway

Often when a static IP address is assigned, a default gateway is also identified. If the default 
gateway is unknown, then type in the Static IP address so that the Static IP address and 
Default Gateway are the same number.

Subnet Mask

This parameter is usually extracted from the Static IP address based upon the class of the 
address. It determines the destination of any broadcast messages that might be sent from the 
instrument. It can be customized if necessary. The subnet mask may also be provided with 
the Static IP address.

Example 1

In this example, a Static IP address has been chosen because no network is available. The 
instrument is connected to the network port on the PC with a crossover Ethernet cable (not 
included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2
Default Gateway: 10.0.0.2
Subnet Mask: 255.255.0.0

Note
The VNA Master must be connected to the network before it is turned on in order 
to allow DHCP to work. Key elements of the DHCP lease are performed only 
during the instrument startup operations or when switching from manual to DHCP.
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Example 2

In this example, the Static IP address has been assigned with an associated gateway and 
subnet mask:

IP Address: 153.56.100.42
Default Gateway: 153.56.100.1
Subnet Mask: 255.255.252.0

F-5 Operating System Tools
A few tools that are built into the Microsoft Windows operating system can assist in making 
some determinations about the network that the PC is plugged into. 

Ipconfig Tool

Typing ipconfig at a command prompt will display information about the in-use parameters of 
the PC and its network connection. Below is an example of the typical results expected. 

Y:\>ipconfig
Windows 2000 IP Configuration
Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix. : us.anritsu.com
IP Address . . . . . . . . . . . . : 172.26.202.172
Subnet Mask . . . . . . . . . . . : 255.255.252.0
Default Gateway . . . . . . . . . : 172.26.200.1

Ping Tool

Another tool that can find out if a selected IP address is already on the network is ping. Ping 
is a harmless way to determine if an address is found on the network and, if it is found, for it 
to reply. Greatly simplified, ping sends out a request to a specific address to determine if it is 
there. If the specific address is found, then it will respond by sending back the same message 
that was received. If it is not found, then the response will be “request timed out.” This means 
that no reply was received from that IP address.

Y:\>ping 172.26.202.172
Pinging 172.26.202.172 with 32 bytes of data:
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Reply from 172.26.202.172: bytes=32 time<10ms TTL=128
Ping statistics for 172.26.202.172:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milliseconds:
Minimum = 0ms, Maximum = 0ms, Average = 0ms

Note
The ipconfig display does not report if the information is from a DHCP server or a 
Static IP setup
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Appendix G — Glossary of Terms
Introduction
The following terms are used in this manual.
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Glossary Terms

Adapter : A fitting that supplies a passage between two sets of equipment when 
they cannot be directly interconnected. 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 

Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

BER : Bit Error Rate or Bit Error Ratio (link quality specification/testing) 
(BER) &nbsp;BER is a measure of transmission quality. &nbsp;The 
ratio of error bits to the total number of bits transmitted. &nbsp;A bit 
error rate of 10-6 refers to an average of one error per million bits. 
&nbsp;It is generally shown as a negative exponent, (for example, 10-7 
which means 1 out of 107 bits are in error or 1 out of 10,000,000 bits are 
in error). &nbsp;&nbsp;Bit Error Rate (BER) is the fraction of a 
sequence of message bits that are in error. 

BERT : Bit Error Rate Test/Tester (BERT) &nbsp;BERT is a test that gauges 
the quality of the T1 or digital line. &nbsp;By sending a known pattern 
to another device across the span the far end device can compare 
incoming pattern to its’ own, thereby indicating bit errors on the line. 

Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 

Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
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itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 

dB : Decibel or deciBel (dB) is a unit for measuring relative power ratios in 
terms of gain or loss. The units of dB are expressed in terms of the 
logarithm to base 10 of a ratio and typically are expressed in watts. For 
example, a -3dB loss indicates a 50% loss in power; a +3dB reading is a 
doubling of power; 10 dB indicates an increase (or a loss) by a factor of 
10; 20 dB indicates an increase (or a loss) of a factor of 100; 30 dB 
indicates an increase (or a loss) by a factor of 1000. 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. A typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 

dBm : dBm is a decibel value referenced to a milliWatt (dBm) &nbsp;This is a 
technique for expressing a power measurement in logarithmic form 
using 1 mW as a reference. &nbsp;dBm is a decibel ratio (log 10) of 
Watts (W) to one milliwatt (1mW). &nbsp;dBm therefore represents 
absolute power. 

DTF : Distance-To-Fault (DTF) &nbsp;&nbsp;DTF is the distance from the 
instrument output connector (or the end of a test lead) to a problem 
area, as indicated by a peak in the displayed signal. 

FFT : Fast Fourier Transform (FFT) is an efficient algorithm to compute the 
Discrete Fourier transform (DFT) and its inverse. FFTs are of great 
importance to a wide variety of applications, from digital signal 
processing to solving partial differential equations to algorithms for 
quickly multiplying large integers. 

Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. It is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. It is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 

GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 to 100 meters. The 
satellites use simple mathematical calculations to broadcast 
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information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

IF : Intermediate Frequency (IF) is a frequency to which a carrier frequency 
is shifted as an intermediate step in transmission or reception. An 
intermediate electromagnetic frequency is generated by a 
superheterodyne radio receiver. 

IP Address : An Internet Protocol address (IP address) is usually a numerical label 
that is assigned to each device (computer or printer for example) that is 
participating in a computer network that uses the Internet Protocol for 
communication. An IP address serves two main functions: location 
addressing and host (or network) interface identification. The Internet 
Protocol originally defined an IP address as a 32-bit number. This was 
known as Internet Protocol Version 4 (IPv4), which is still in use. 
Growth of the Internet requires a new addressing system. An Internet 
Protocol Version 6 (IPv6) that uses 128 bits for the address was 
developed in 1995, and it is standardized as RFC 2460. IPv6 began 
being deployed worldwide in the year 2000. IP addresses are binary 
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numbers, but they are usually stored in text files and displayed in 
human-readable notations, such as decimal nnn.nnn.nnn.nnn or 
172.16.255.1 (for IPv4), and hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal 
group (nnn) represents values from 000 to 255, or binary values of 8 
bits. In IPv6, each hexadecimal group (nnnn) represents values from 
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 
1111 1111 1111). 

IPv6 : Internet Protocol Version 6 (IPv6) is a numerical label that is used to 
identify a network interface of a computer or other network node 
participating in an IPV6-enabled computer network. IPv6 uses 128 bits 
for the address (as compared to an IPv4 address, which is defined as a 
32-bit number). IPv6 was developed in 1995, and it is standardized as 
RFC 2460. IPv6 began being deployed worldwide in the year 2000. IP 
addresses are binary numbers, but they are usually stored in text files 
and displayed in human-readable notations, such as hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec]). 
Each hexadecimal group (nnnn) represents values from 0000 to FFFF, 
or binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 
1111). 

LPA : Linear Power Amplifier (LPA) is the final amplification stage in a 
multicarrier transmitter that has been designed and optimized to 
produce a linear response. By operating in the linear mode, the 
amplifier reduces the non-linear effects that produce intermodulation 
products and side-lobe spectra that cause adjacent channel interference. 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. NF (the noise figure) is defined 
as the decibel value of the noise factor. NF = 10log (F) where log uses 
the base 10, or common log. This formula is valid only then the input 
termination is at standard noise temperature. 

OBW : Occupied Bandwidth (OBW) &nbsp;Occupied Bandwidth is a measure 
of the bandwidth containing 99% of the total integrated power of the 
transmitted spectrum, centered on the assigned channel frequency. 
&nbsp;Interference to other channels or to other systems can occur if 
OWB is too large. 

OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 
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RBW : Resolution Bandwidth (RBW) &nbsp;With spectrum analyzers, a 
narrow band filter is swept across a frequency span to create the 
spectrum display. &nbsp;The filter bandwidth (RBW) determines the 
frequency resolution across the frequency axis. 

Signal loss : Signal loss is the amount of signal strength that’s lost in antenna cable, 
connectors, and free space. Signal loss is measured in decibels. 

Smith Chart : A Smith Chart is a graphical aid for electrical and electronics 
characteristics in radio frequency (RF) circuits.&nbsp; Smith Chart was 
invented by Phillip Smith at Bell Laboratories in 1939.&nbsp; The 
chart can be used to display multiple parameters, such as impedance, 
and admittance. 

S-parameter : S-parameters are scattering parameters, and are a signal ratio of 
reflection and transmission measurements. For a 2-port network, four 
fundamental S-parameters can be measured, and they are defined as 
Sxy (where x and y are subscripts of S). The first number (x) is the port 
number into which the signal is being injected, and the second number 
(y) is the port number from which the signal is leaving. The 
S-parameter is the ratio of these two signals. S11 is Forward Reflection. 
&nbsp;S21 is Forward Transmisssion. S12 is Reverse Transmission. 
S22 is Reverese Reflection. 

TMA : A Tower Mounted Amplifier (TMA) amplifies signals from an antenna 
to reduce the noise figure of a base transceiver station (BTS). This helps 
to improve the overall sensitivity of the BTS. &nbsp;A TMA is a 
low-noise amplifier (LNA) that is usually mounted as close as practical 
to the antenna in Base Transceiver Stations or in mobile masts. When 
using a TMA, the antenna is able to receive weaker signals. 
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